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本書について
このドキュメントは、パイロット環境に CCF (Customer Care Framework) を設定する場合に必要な手順を記載しています。 

はじめに
カスタマ ケアはサービス プロバイダの成功に最も影響を与える要因となりました。 顧客に最高レベルの満足度を提供するには、サービス プロバイダは電話など幅広くアクセスできる媒体による顧客サポート、つまり、大規模コール センターのエージェントやユーザー フレンドリなセルフ サービス ポータルなどで提供されるサポートを提供する必要があります。彼らは、プロビジョニング、技術的なサポート、請求書に関する質問への回答、既存の顧客に新製品を高価格で販売するなどさまざまなサービスを顧客へ提供しています。 

Microsoft Customer Care Framework の最新バージョンである CCF 2.0 は、コンタクト センターのアプリケーションやセルフ サービス ポータルの開発およびメンテナンス コストを削減する場合に役立ちます。 また CCF 2.0 は既存の基幹業務 (LOB) アプリケーションをスムーズかつ簡単に統合し、運用効率を改善します。
以下のダイアグラムは CCF2.0 の展開アーキテクチャを示しています。
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図 1: CCF2.0 展開アーキテクチャ
CCF2.0 はさまざまなモジュールで構成されています。 それらのモジュールを以下に説明します。
1. 顧客サービス担当者アプリケーション (エージェント デスクトップ)
エージェント・デスクトップ・アプリケーションは、顧客に対応するために顧客サービス担当者 (CSR) が使用します。 顧客からのコールは CSR へ転送されます。CSR はエージェント・デスクトップ上でその顧客の詳細情報をすべて入手します。 CSR はエージェント デスクトップでホストされたアプリケーションを使用し、顧客の質問に答えます。
コンタクト センターの管理者はアドミニストレータ ツールを使用し、その CSR のエージェント・デスクトップを構成します。
2. 顧客のセルフ サービス ポータル
顧客は、顧客のセルフ サービス ポータル ページを参照することで Web 上ですべての詳細情報およびトランザクションを表示できます。 これはポータルであり、コンタクト センターの要件に合わせて変更できます。
3. Information Bridge Framework ブローカー
MS Office は CSR の中でも最も一般的なアプリケーションです。 IBF (Information Bridge Framework) は LOB アプリケーションと MS Office アプリケーション間のすき間を埋めようとします。 LOB アプリケーションが IBF 経由で Office にアクセスするには、LOB アプリケーションには IBF 互換の Web サービスが必要です。
IBF ブローカー コンポーネントは、プログラミング インタフェースを持たない LOB アプリケーションに対してこれらの種類の Web サービスを作成する場合に役立ちます。
4. データの抽象化およびキャッシュ レイヤ
データの抽象化およびキャッシュ レイヤはBizTalk Server 2004 を使用して LOB アプリケーションのパフォーマンスを向上させます。バインディングとキャッシングという 2 つの主なモジュールがこの役割を果たします。 バインディング モジュールは、純粋に非同期的な方法で LOB アプリケーションから結果を入手します。 キャッシング モジュールは、時間が掛かることのある LOB アプリケーションの結果および要求を処理するためのリソースをキャッシュします。
用語および代替用語表
1. このセクションでは、ドキュメント内の変数を表す場合に使用する各種用語を説明しています。  CCF2.0 パイロット展開の目的では、変数 <DomainController> で表されるドメイン コントローラを表す場合は CCFDC、変数 <DomainName> で表される NetBIOS ドメイン名を表す場合は CCF、また変数 <CCFFQDN> で表されるその FQDN はCCF.demo、変数 <IISSvr> で表される IIS サーバー名を表す場合は CCFIIS を使用します。 CCFSQL は変数 <SQLSvr> で表される SQL サーバー名を表すといった具合になります。実際の展開では、これらのタグが見つかった場合はこれらの変数をドメイン内の実際の名前と置き換えることができます。 このドキュメントでは、適切な場合はいつでも以下の用語を交互に使用します。 <DomainName> = CCF
2. <CCFFQDN> = CCF.demo
3. <DomainController> = CCFDC
4. <SQLSvr> = CCFSQL 
5. <IISSvr> = CCFIIS
6. <UnzipDir> = C:\CCF2.0
7. <OSDrive> = C:
8. <AgentDesktopInstallDir> = C:\Program Files\Microsoft\CCF Contact Center Agent Desktop
9. <wwwrootDir> = C:\InetPub\wwwroot
10. <CCFAdminAcct> = CCFAdmin
11. <CCFAdminPW> = ourPassword
12. <CSSWebServer> = CSSWebServer
13. <ReportSvr> = CCFRS
顧客サービス担当者アプリケーション (エージェント デスクトップ) 
CSR はエージェント デスクトップ、必要なコンポーネント、および管理コンソールとその依存するコンポーネントで構成されています。
以下のダイアグラムは CSR のパイロット環境の様子を示しています。
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図 2: エージェント デスクトップのパイロット環境
注: 実稼働環境に実装する場合、展開アーキテクチャが上記のパイロット展開アーキテクチャから派生したものであり、サーバーとクライアント間の必要なネットワーク通信が阻害されない限り、展開アーキテクチャをカスタマイズできます。
CCF v1.02 がインストールされている場合は、Upgrading from earlier version of CCF を参照して CCF v2.0 へアップグレードします。
CSR サーバーとクライアントのインストール順序は以下のとおりです。
· ドメイン コントローラ
· SQL サーバー
· IIS サーバー
· SQL レポート サーバー
· クライアント デスクトップ
必要なソフトウェア
インストールを始める前に、以下の点を確認してください。
Windows 2000 Server のハードウェア要件を満たすまたはそれを超えるサーバー 1 台  (<SQLSvr>)。
Windows 2003 SP1 Server のハードウェア要件を満たすまたはそれを超えるサーバー 3 台 (<DomainController>、<IISSvr>、および <ReportSvr>)
Windows XP Professional のハードウェア要件を満たすまたはそれを超えるクライアント デスクトップ 2 台。
6 個以上のポートおよび 5 本のケーブルを備えたイーサネット スイッチまたはハブ 1 台。
以下のソフトウェア用メディア:
Windows 2003 SP1 Server
Windows 2000 Server
Windows 2000 SP 3 (以上)
SQL サーバー 2000 Standard
SQL サーバー 2000 SP 3a 以降
SQL Reporting Services 2000 以降
Windows XP Professional
Windows XP SP 2
Enterprise Instrumentation Framework セットアップ


 http://msdn.microsoft.com/vstudio/enterprise/EIF/ で現在利用できます。
.NET Framework V 1.1
Microsoft エンタープライズ シングル サインオン (Microsoft BizTalk Server 2004 メディアの一部である ESSO)CCF-CSR セットアップ

Office インテグレーションを使用している場合 (サンプルのホスト アプリケーション用):Office XP SP1 または Office 2003
Office XP Primary Interop Assemblies
以下の手順は、Windows 2003 Server を [Configure your Server] ウィザードでドメイン コントローラとして構成し、アプリケーション サーバー、ファイル サーバー、および DNS を構成していることを前提としています。 これらの役割は各マシンにそれぞれ分割できます。
ドメイン コントローラ
このマシンのオペレーティング システムは Windows 2003 SP1 Server です。
注: Active Directory をストアの種類として Authorization Manager を構成しなければならない場合は、マシンのオペレーティング システムは Windows Server 2003 SP1 になります。
インストール手順
マシン: <DomainController>
ログイン ユーザー: ドメイン管理者
1. Windows 2003 SP1 Server をインストールします。 

2. DCPromo を実行してこのサーバーをドメイン コントローラへ昇格させます。CCF は NetBIOS 名で CCF.demo はこのパイロット展開の FQDN です。
以下に示す手順に従ってください。
注: 以下のプロセスには Windows server 2003 CD が必要です。
a. [Start]--> [Run]---> の順にクリックし、DCPromo と入力して Enter キーを押します。 [Active Directory Installation] ウィザードが起動します。
b. ようこそ画面で [Next] をクリックします。
c. [Operating System Compatibility] という画面で、[Next] をクリックします。
d. [Domain Controller Type] 画面で、[New Domain] の [Domain Controller] をクリックして、[Next] をクリックします。
e. [Create New Domain] 画面で、[Create New section] 下の[Domain in a new Forest] オプションをクリックし、[Next] をクリックします。
f. [New Domain Name] 画面で作成するドメイン名を指定します  (このパイロット展開では、ドメイン名は CCF.demo)。 [Next] をクリックします。
g. 検証メッセージで [Ok] をクリックします。
h. [NetBIOS Domain Name] 画面で NetBIOS ドメイン名を指定します  (このパイロット展開では、ドメイン名は CCF)。 [Next] をクリックします。
i. [Active Directory and Log Location] 画面で、既定値を設定し、[Next] をクリックします。
j. [Shared System Volume] 画面で、既定値を設定し、[Next] をクリックします。
k. [DNS Registration Diagnostics] 画面で、[Install and configure the DNS server on this computer and set this computer to use this DNS server as its preferred DNS server.] をクリックします。 [Next] をクリックします。
l. [Permissions] 画面で、[Permissions compatible only with Windows 2000 or Windows 2003 Operating Systems.] をクリックします。 [Next] をクリックします。
m. [Directory Services Restore Mode Administrator Password] 画面で、ドメイン管理者のパスワードを指定します。 [Next] をクリックします。
n. [Summary] 画面で [Next] をクリックします。
ASPUSER ユーザー アカウント
特権が低い特別のドメイン アカウントを作成する必要があります。このアカウントは IIS サーバーで既定の ASPNET アカウントを置き換えます。 このアカウントの名前は ASPUSER です。 統合セキュリティを使用してデータベース サーバーへアクセスします。 これもまた、その目的で使用されるアカウントです。 最後になりますが、アドレス帳機能の LDAP クエリもこのユーザー コンテキストで動作します。
1. [Start] -> [Program] -> [Administrative Tools] -> [Active Directory Users and Computers] の順にクリックします。
2. [<CCFFQDN>] ノードをダブルクリックすると、[Builtin]、[Computers]、[Domain Controllers]、[Foreign Security Principles]、[Users] というオブジェクトがツリー ビューに表示されます。 ツリー ビューの[Users] オブジェクトをクリックします。
3. ツール バーで [Add user] アイコン ([Single Person] アイコン) をクリックします。
4. ログオン名に ASPUSER を入力します。 ユーザーの [First Name] と同様に入力し、[Next] をクリックします。
5. パスワードを入力します。 [Password never expires] チェック ボックスをオンにします。 このアカウントに割り当てられたパスワードをメモします。 これで新しいドメイン ユーザーが作成されました。
6. ASPUSER が Domain Users グループに自動的に追加されます。
CCFUsers ユーザー グループ
<DomainName> ドメインでユーザー グループを作成する必要があります。 Web サービスを使用するには、エージェント デスクトップで使用するすべてのエージェントをこのグループに追加する必要があります。 このユーザー グループの名前は CCFUsers です。
1. 新しいユーザー グループ CCFUsers を作成します。
· [Start] -> [Program] -> [Administrative Tools] -> [Active Directory Users and Computers] の順にクリックします。  

· [<CCFFQDN>] ノードをダブルクリックすると、[Built-in]、[Computers]、[Domain Controllers]、[Foreign Security Principles]、[Users] というオブジェクトがツリー ビューに表示されます。 ツリー ビューの[Users] オブジェクトをクリックします。
· ツール バーで [Add user Group] アイコン ([Two Person] アイコン) をクリックします。
· グループ名に CCFUsers を入力し、残りの既定値を設定します。 
CCFAdmins ユーザー グループ
<DomainName> ドメインでユーザー グループを作成する必要があります。 すべての CCF 管理者をこのグループへ追加する必要があります。 このグループは、データベースや CCF アプリケーションおよびデータベースや AzMan ストアのようなアプリケーション リソースを完全に管理します。 このユーザー グループに属するユーザーは、管理コンソールで CCF を管理したり、SQL サーバー クライアント ソフトウェアおよびダイレクト ファイル アクセスによりリソースに直接アクセスできます。 管理 Web サービスはこれらのユーザーのみ認証します。
1. 新しいユーザー グループ CCFAdmins を作成します。
· 新しいユーザー グループを作成するには、CCFUsers グループ作成で使用した手順に従います。 
2. ユーザー名が CCFAdmin でパスワードが <CCFAdminPW> の新規ユーザーを CCF ドメインに作成します。 これを作成するには、ASPUSER User Account セクションの手順1 から 4 に従います。
3. CCF 管理者アカウント CCFAdmin を CCFAdmins ユーザー グループに追加します。
注: 1 つ以上の新規または既存のアカウントを CCFAdmins グループに追加し、それらを CCF アプリケーション管理者として昇格させることができます。
DNS エントリ
この CCF 2.0 のパイロット展開では、各種モジュールでアクセスされる URL において、IIS サーバーと SQL サーバーはそれぞれ CCFIIS および CCFSQL と識別されています。 IIS サーバーと SQL サーバーのマシン名がそれぞれ CCFIIS および CCFSQL とは異なる場合は、以下の手順に従って、実際の IIS サーバー マシン名と SQL サーバー マシン名と一致する DNSホスト名 CCFIIS および CCSQL を作成してください。
1. <DomainController> マシンで、[Start] -> [Programs] -> [Administrative Tools] -> [DNS] の順にクリックします。
2. [<DomainController>] ノードを展開します。
3. [Forward Lookup Zones] ノードを展開します。
4. [<CCFFQDN>] を右クリックします。
5. [New Host (A) ….] をクリックします。
6. 新しい[Host] ダイアログで、名前に CCFIIS を IP アドレスに < IISSvr> マシンの IP アドレスを入力します。 これで <IISSvr> マシンも名前 CCFIIS で識別されます。
7. <SQLSvr> に対しても手順 1 から 6 を繰り返します。 手順 6 で、名前に CCFSQL を IP アドレスに <SQLSvr> マシンの IP アドレスを入力します。 これで <SQLSvr> マシンも名前 CCFSQL で識別されます。
SQL Server
このマシンのオペレーティング システムは Windows 2000 Server 以降になります。
インストール手順
マシン: <SQLSvr>
ログイン ユーザー: ローカル管理者
1. Windows 2000 Server をインストールし、CCF ドメインに参加します。
2. 最新の Windows Service Pack をインストールします。 

3. SQL Server 2000 Standard Edition をインストールします。 既定ライセンス数は 0 です。ユーザーはこの数を少なくとも 1 つずつ増やす必要があります。 ウィザードの残りのオプションは既定値を選択します。
4. SQL Server 2000 SP3a をインストールします。
5. 登録中に <SQLSvr> サーバーが登録されていない場合は、登録が必要です。 <SQLSvr> サーバーを登録するには、[Start]->[Programs]-> [Microsoft SQL Server]-> [Enterprise Manager] の順にクリックします。 [Microsoft SQL Servers] アイコンが表示されます。
a. [Microsoft SQL Servers] アイコンをダブルクリックすると、[SQL Server Group] が表示されます。
b. [SQL Server Group] を右クリックし、[New SQL Server Registration] をクリックしてから、ウィザードに従って <SQLSvr> サーバーを SQL Server グループへ追加します。
注: SQL Server はインストール中に、"(ローカル) Windows NT" の名前で Enterprise Manager に自動的に登録されます。 整合性と明確さを考え、Enterprise Manager のこのノードはこのドキュメントでは <SQLSvr> と呼ばれます。
6. CCF2.0 セットアップ パッケージの内容を <UnzipDir> へ抽出します。 このデモ展開では、c:\CCF2.0 を使用しています。
7. BizTalk インストールの前提条件として以下の手順が必要です。
a. [Start] をクリックして、[Run] をクリックします。 [Open] ボックスで、regedit と入力し [OK] をクリックします。 
b. 以下のレジストリ サブキーを見つけ、クリックします。
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\MSDTC\TurnOffRpcSecurity
注: このサブキーが存在しない場合は、作成してください。 
c. コンソールの右ペインの [(Default)] をクリックし、[Edit] メニューで [Modify] をクリックします。 
d. [Value] ボックスで、1 と入力し [OK] をクリックします。 
e. レジストリ エディタを終了します。 
f. マシンを再起動します。
IIS サーバー
インストール手順
マシン: <IISSvr>
ログイン ユーザー: ドメイン管理者
1. Windows 2003 SP1 Server をインストールし、CCF ドメインに参加します。 
注: IIS 6.0 および ASP.NET がインストールされていることを確認します。 

2. クライアント ツール オプションなど SQL 2000 クライアントをインストールします  (これはデータベース をインストールするために <SQLSvr> と接続する場合に必要です)。
注: 最新の SQL Server Service Pack がインストールされていることを確認します。
3. Enterprise Instrumentation Framework をインストールします。 これは現在 http://msdn.microsoft.com/vstudio/enterprise/EIF/ で利用できます。
4. Microsoft エンタープライズ シングル サインオンをインストールします。 これは BizTalk Server 2004 の一部です。
· BizTalk Server の前提条件Microsoft XML 4.0 SP2 以降
http://www.microsoft.com/downloads/details.aspx?FamilyID=3144b72b-b4f2-46da-b4b6-c5d7485f2b42&DisplayLang=en からダウンロードできます。
· Microsoft SQL XML 3.0 SP3
http://www.microsoft.com/downloads/details.aspx?FamilyID=51d4a154-8e23-47d2-a033-764259cfb53b&DisplayLang=en からダウンロードできます。
BizTalk をインストールするためにサーバーを構成するには、以下の手順に従います。
マシン: <IISSvr>
ログイン ユーザー: ローカル管理者
1. [Start] メニューで、[Control Panel]、[Administrative Tools]、[Component Services] の順にダブルクリックします。 
2. [Component Services]、[Computers] の順に展開します。 
3. [My Computer] を右クリックし、コンテキスト メニューで [Properties] をクリックします。 
4. [Properties] ウィンドウで、[MSDTC] タブをクリックします。 
5. [Transaction Configuration] エリアで、[Security Configuration] をクリックします。 
6. [Security Settings] エリアで、[Network DTC Access] チェック ボックスをオンにします。 
7. [Client And Administration] エリアで、[Allow Remote Clients] チェック ボックスをオンにします。
8. [Transaction Manager Communication] エリアで、[Allow Inbound] チェック ボックス、[Allow Outbound] チェック ボックスの順にクリックし、[No Authorization Required] をクリックします。
9. それぞれ開いたダイアログ ボックスで [OK] をクリックします。 
10. コンピュータを再起動してリモート DTC オプションを有効にします。 
CCF IIS マシンで以下の手順を実行する必要があります。
マシン: <IISSvr>
ログイン ユーザー: ローカル管理者
[Start] をクリックし、[Run] をクリックします。 [Open] ボックスで、regedit と入力し [OK] をクリックします。 以下のレジストリ サブキーを見つけ、クリックします。HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\MSDTC\TurnOffRpcSecurity
注: このサブキーが存在しない場合は、作成してください。 
1. コンソールの右ペインの [(Default)] をクリックし、[Edit] メニューで [Modify] をクリックします。 
2. [Value] ボックスで、1 と入力し [OK] をクリックします。 
3. レジストリ エディタを終了します。 
4. <IISSvr> マシンを再起動します。
BizTalk Server 2004 ESSO 部分のインストール手順:
マシン: <IISSvr>
ログイン ユーザー: ローカル管理者
1. setup.exe をクリックします。
2. インストール ウィザード画面で [Install] リンクをクリックします。
3. [Customer information] 画面で、適切な情報を指定し、有効なプロダクト キーを入力して、[Next] をクリックします。
4. [License Agreement] 画面で [Accept] をクリックします。
5.  [Installation Options] 画面で [Custom] をクリックし、[Next] をクリックします。
6. [Custom Installation] 画面で、すべての項目を選択解除し、以下の項目のみ選択して [Next] をクリックします。
· BizTalk Server 2004 Help
· Enterprise Single Sign-On
· Enterprise Single Sign-On Administration
7. [Summary] ページで [Install] をクリックします。
8. [Installation completed] 画面で、画面で利用できる [Launch Configuration Wizard] オプションをクリックし、[Finish] をクリックします。 
構成ウィザード設定:
1. [Welcome Configuration] 画面で [Next] をクリックします。
2. [Configuration Options] 画面で、[Will this Single Sign On server (SSO) hold the master secret key?] に対して [Yes] をクリックします。 注: [The first server you configure in your SSO system must be Master Secret Server] ボックスで、[Next] をクリックします。
3. [Windows Accounts] 画面で [Next] をクリックします。
4. [Database Configuration] 画面で、すべてのエントリでサーバーに <SQLSvr> を指定し、[Next] をクリックします。
5. [Windows Service Configuration] 画面で、[Enterprise Single Sign On services] をクリックし、[Edit] ボタンをクリックします。
6. [Enterprise Single Sign On Service Properties] ウィンドウで、アカウント <DomainName>\Administrator または Administrator@<DomainName> (CCF\administrator または Administrator@CCF など) とそのパスワードを入力し、[OK] をクリックします。
7. [The specified account is an Administrator on this computer.  [Are you sure you want to use an account with Administrative Privileges] というプロンプトが表示されたら、[OK] をクリックします。
8. [Windows Service Configuration] 画面で [Next] ボタンをクリックします。
9. [Summary] 画面で [Next] をクリックします。
10. [Configuration Completed] 画面で [Finish] をクリックします。
注: 何らかの理由で正しく構成されなかった場合は、C:\Program files\Microsoft BizTalk Server 2004\ConfigFramework.exe. から再度行うことができます。
5. 以下の手順に従って ASPUSER を IIS_WPG グループに追加します。
a. マシンのデスクトップで [MyComputer] アイコンを右クリックします。
b. [Manage] をクリックします。
c. [System Tools] 下で [Local Users and Groups] をクリックし、[Users and Groups] フォルダを表示します。
d. [Groups] をダブルクリックし、[IIS_WPG] を開きます。
e.  [Add] をクリックして、<DomainName>\ASPUSERを IIS Worker Process Group に追加し、[OK] をクリックします。
6. <DomainName>\ASPUSER および <DomainName>\CCFAdmins には以下の ACL が CCFIIS で必要です。以下の変更を行うには、エクスプローラを開き以下の手順で示す既定の場所に移動します。
· フォルダのアクセス許可:
· 既定の場所: <OSDRIVE>\Windows\TEMP
· アクセスの種類: Full Control
· ASP .NET Dynamic Compilation フォルダ:
· 既定の場所: <OSDRIVE>\WINDOWS\Microsoft.NET\Framework\v1.1.4322\Temporary ASP.NET Files
· アクセスの種類: Full Control
· ASP .NET インストール フォルダ
· 既定の場所: <OSDRIVE>\Windows\Microsoft.NET\Framework\v1.1.4322 
· アクセスの種類: Read & Execute、List Folders Contents、Read
7. すべての CCF Web アプリケーションで使用される ASPUSER という ID を持つ CCFAppPool という新しいアプリケーション プールを作成します。
a. [Start] -> [Program] -> [Administrative Tools] -> [Internet Information Services (IIS) Manager] の順にクリックします。
b. [<IISSvr>] ノードを展開します。
c. [Application Pools] を右クリックします。
d. [New] -> [Application Pool] の順にクリックします。
e. Application pool ID というラベルが付いたボックスに CCFAppPool と入力します。
f. オプション [Use default settings for new application pool] が選択されていることを確認します。
g. [OK] をクリックします。
h. [CCFAppPool] を右クリックし、[Properties] をクリックします。
i. [Identity] タブをクリックします。
j. [Configurable] をクリックします。
k. ユーザー名に <DomainName>\ASPUSER を入力し、<DomainName>\ASPUSER のパスワードを入力します。
l. [OK] をクリックします。
これで IIS Worker プロセスの ID が変更されました。 Kerberos 認証を使用するには、IIS Worker プロセスに Service Principal Name (SPN) を登録する必要があります。 この SPN は、IIS Worker プロセスが動作している Active Directory のアカウント下に登録する必要があります。 既定では、Active Directory は NetBIOS または IIS サーバーのマシン名を登録し、ネットワーク サービス アカウントまたはローカル システム アカウントを Kerberos で使用できるようにします。 詳細については、http://www.microsoft.com/technet/treeview/default.asp?url=/technet/prodtechnol/windowsserver2003/proddocs/standard/CA_CFgwrkridentity.asp を参照してください。
8. CCF2.0 セットアップ パッケージの内容を <UnzipDir> へ抽出します。
Kerberos 認証用 SPN
IIS サーバーの CCF Web サービスのアプリケーション・プールは既定のアカウント (ネットワーク サービス) ではなくその ID として特定のドメイン アカウント (CCF\ASPUSER) を持つよう構成されているため、認証を正しく動作させるために、<IISSvr> マシンで動作している HTTP サービスに対して CCF\ASPUSER アカウント用 SPN を登録する必要があります。 これを行うには、以下の手順に従います。
マシン: <DomainController>
ログイン ユーザー: ドメイン管理者
1. Windows 2003 CD からサポート ツールをインストールします。 サポート ツールは Windows 2003 CD-ROM の SUPPORT\TOOLS フォルダに存在します。 その場所に移動し suptools.msi ファイルをダブりクリックしてインストール ウィザードを起動します。
2. コマンド プロンプトを開き、現在のディレクトリを <OSDRIVE>\Program Files\Support Tools に設定します。
3. 展開環境が以下のシナリオに一致したとします。
· CCFIIS – IIS マシンの NetBIOS 名 (<IISSvr> 以外など)
· CCFIIS.ccf.demo – IIS マシンの FQDN 名
· CCF\ASPUSER –セクション ASPUSER User Account で作成された ASPUSER アカウント
その場合は、コマンド プロンプトで以下のコマンドを実行します。
a. Setspn.exe -A HTTP/CCFIIS CCF\ASPUSER
b. Setspn.exe -A HTTP/CCFIIS.ccf.demo CCF\ASPUSER
展開環境が以下のシナリオに一致したとします。
· XYZ – “CCFIIS” と異なる IIS マシンの NetBIOS 名
· XYZ.ccf.demo – “CCFIIS.ccf.demo” と異なる IIS マシンの FQDN 名
· CCFIIS – DNS Entries セクションで作成された IIS マシンの DNS ホスト名
· CCFIIS.ccf.demo – DNS Entries セクションで作成された IIS マシンの完全修飾 DNS ホスト名
· CCF\ASPUSER –セクション ASPUSER User Account で作成された ASPUSER アカウント
その場合は、コマンド プロンプトで以下のコマンドを実行します。
a. Setspn.exe -A HTTP/XYZ CCF\ASPUSER
b. Setspn.exe -A HTTP/XYZ.ccf.demo CCF\ASPUSER
c. Setspn.exe -A HTTP/CCFIIS.ccf.demo CCF\ASPUSER
展開環境が以下のシナリオに一致したとします。
· XYZ – “CCFIIS” と異なる IIS マシンの NetBIOS 名
· XYZ.ccf.demo – “CCFIIS.ccf.demo” と異なる IIS マシンの FQDN 名
· IIS マシンには DNS ホスト名は作成されていません。
· CCF\ASPUSER –セクション ASPUSER User Account で作成された ASPUSER アカウント
その場合は、コマンド プロンプトで以下のコマンドを実行します。
d. Setspn.exe -A HTTP/XYZ CCF\ASPUSER
e. Setspn.exe -A HTTP/XYZ.ccf.demo CCF\ASPUSER
SQL レポート サーバー
インストールを始める前に、以下の点を確認してください。
このメディアには以下のソフトウェアが必要です。
· Windows 2003 SP1 Server
· IIS 6.0 with ASP.NET
· SQL Reporting Services 2000 以降
· .NET Framework 1.1
· Internet explorer 6.0 以降
インストール手順
マシン: <ReportSvr>
ログイン ユーザー: ローカル管理者
1. 既定のアプリケーション プールの構成 SQL Reporting Services は常にネットワーク サービス アカウントで動作します。 SQL Reporting Services は常に IIS の既定のアプリケーション プールにインストールされます。 既定のアプリケーション プールが異なる ID で動作している場合は、ネットワーク サービス ID を使用するよう変更する必要があります。 IIS サーバーの既定のアプリケーション プールの ID を変更するには、以下の手順に従います。
· [Start] -> [Program] -> [Administrative Tools] -> [Internet Information Services (IIS) Manager] の順にクリックします。
· [<ReportSvr>] ノードを展開します。
· [<ReportSvr>] ノードの [Application Pools] を展開します。
· [Application Pools] で [DefaultAppPool] をクリックします。
· [DefaultAppPool] を右クリックし、[Properties] をクリックします。
· [Identity] タブをクリックします。
· [Predefined] をクリックします。
· ドロップ ダウン リスト ボックスの [Network Service] をクリックします。
· [Apply] をクリックし、[OK] をクリックします。
2. SQL Reporting Services のインストール
a. SQL Reporting Services の前提条件が満たされていることを確認します。
b. SQL Reporting services のセットアップを起動します。 

c. [Feature Selection] ページが表示されるまで [Next] をクリックします。
d. [Feature Selection] ページで [Will be installed on local hard drive] に [Server components] が選択されていることを確認します。
e. [Next] をクリックします。
f. [Service Account] ページで、ドメイン ユーザーをクリックし、<DomainName>\Administrator 証明を入力して、[Next] をクリックします。
g. [Reporting Services Virtual Directories] ページで SSL オプションのチェック ボックスをオフにし、[Next] をクリックします。
h. [Report Server Database] ページで、[SQL Server Instance] ボックスに <SQLSvr> と入力します。
i. [CredentialType] ボックスで [Domain User Account] を選択するように変更します。
j. [User Name]、[Password]、[Domain] ボックスに <DomainName>\Administrator の証明を入力します。
k. [Next] をクリックします。
l. [Report Server Delivery Setting] 画面で [Next] をクリックします。 CCF のパイロット展開では SMTP サーバーを指定する必要はありません。
m. ここで既定値は 0 になります。したがって、[Per Seat License] モードに 5 を入力するよう文章を修正します。
n. [Install] をクリックしてインストールを開始します。
CCF Web サービスのインストール
ContactCenter Web Services、ContactCenterAIF Web Services、AgentCredentials Web Services、および AdminConsole Web Services を IIS サーバー マシンにインストールする必要があります。 Web サービスをインストールしているときは、ログイン ユーザー アカウントはドメイン管理者になります。
CCF Web サービスのインストール手順
マシン: <IISSvr>
ログイン ユーザー: ドメイン管理者
Contact Center Web Services をインストールするには、以下の手順に従います。
1. IIS サーバー マシンで <UnzipDir>\Setup\CSR\WebServices\ContactCenter\Setup.exe を実行します。 

2. ウィザードで既定値を選択します。 Contact Center Web Services の仮想ディレクトリが作成されます。
Contact Center AIF Web Services をインストールするには、以下の手順に従います。
1. IIS サーバー マシンで <UnzipDir>\Setup\CSR\WebServices\ContactCenterAIF\Setup.exe を実行します。
2. ウィザードで既定値を選択し、セットアップを完了します。 Contact Center AIF Web Services の仮想ディレクトリが作成されます。
3. <UnzipDir>\Others\Settings\AzManCCF.xml を IIS サーバー マシンの <wwwrootDir>\ContactCenterAIF 仮想ディレクトリへコピーします。
AgentCredentials Web Services をインストールするには、以下の手順に従います。
1. IIS サーバー マシンで <UnzipDir>\Setup\CSR\WebServices\AgentCredentials\Setup.exe を実行します。 

2. ウィザードで既定値を選択し、セットアップを完了します。 Agent Credentials Web Services の仮想ディレクトリが作成されます。
Admin Console Web Services をインストールするには、以下の手順に従います。
1. IIS サーバー マシン (またはこれを読み込んでいるシステム) で <UnzipDir>\Setup\CSR\WebServices\AdminConsoleWS\Setup.exe を実行します。
2. ウィザードで既定値を選択し、セットアップを完了します。 Admin Console Web Services の仮想ディレクトリが作成されます。
3. 管理コンソール アプリケーションを使用する有効なユーザーを構成するには、コマンド プロンプトで以下のようにバッチ ファイル <UnzipDir>\Setup\CSR\WebServices\AdminConsoleWS\ create_admin_user_key.bat’ を実行します。
create_admin_user_key CCF\CCFAdmin ourPassword 
注: ここで CCF\CCFAdmin および ourPassword はそれぞれ <DomainName>\<CCFAdminAcct> と <CCFAdminPW> を表しています。 CCFAdmins セクションで作成された CCF 管理者アカウントのユーザー名およびパスワード以外です。 上記のバッチ ファイル実行後に ASPNET_SETREG キーが HKEY_LOCAL_MACHINE\SOFTWARE\CCF 下のレジストリに作成されていることを確認します。
4. 以下のレジストリ キーの名前を変更します。
HKEY_LOCAL_MACHINE\SOFTWARE\CCF\ASPNET_SETREG
この行を次のように変更します。
HKEY_LOCAL_MACHINE\SOFTWARE\CCF\AdminUser
“AdminUser” はレジストリ キーの名前であり、ユーザー アカウント名ではありません。
(create_admin_user_key.bat バッチ ファイルで実行される Microsoft 提供の) ツール “aspnet_setreg.exe” が共通名を持つレジストリ キー (ASPNET_SETREG) を作成するため、名前の変更が必要です。 しかし、アプリケーションを表現するために正しい名前を付ける必要があります。
Web サービスがこのレジストリ キーを読み取れるようにするには、レジストリ キー HKEY_LOCAL_MACHINE\SOFTWARE\CCF\AdminUser の IIS_WPG ローカル ユーザー アカウントに読み取りアクセス許可を与えます。 
読み取りアクセス許可を与えるには、以下の手順に従います。
a. レジストリ エディタ アプリケーションを開きます  ([Start] -> [Run] で regedit と入力し、Enter キーを押します)。
b. 以下のキーへ移動します。
HKEY_LOCAL_MACHINE\SOFTWARE\CCF\AdminUser.
c. レジストリ キーを右クリックし、[Permissions] をクリックします。
d. [Add] をクリックし、ローカル マシンの [IIS_WPG] ユーザー グループをクリックします。
e. [Read] ボックスをクリックします。
f. [OK] をクリックします。
5. ホスト アプリケーションのアクセス構成は AzmanCCF.xml ファイルに設定されています。 CCF 管理者がこのファイルを変更するには、Full Control アクセス許可をファイルの <DomainName>\CCFAdmins ドメイン グループに指定する必要があります。
<wwwrootDir>\ContactCenterAIF\AzManCCF.xml
Web サービス構成オプション
マシン: <IISSvr>
ログイン ユーザー: ローカル管理者
1. 以下の手順に従って、ContactCenter、ContactCenterAIF、AgentCredentials、および AdminConsoleWS 仮想ディレクトリの匿名アクセスを無効にします。
a. [Start] -> [Program] -> [Administrative Tools] -> [Internet Information Services (IIS) Manager] の順にクリックします。
b. [<IISSvr>] -> [Web Sites] -> [Default Web Site] の順に移動します。
c. [Default Web Site] で [ContactCenter] をクリックします。
d. 表示されたメニューで右クリックし、[Properties] をクリックします。
e. [Authentication and Access Control] セクションで [Directory Security] タブをクリックし、[Edit] をクリックします。
f. [Anonymous access] チェック ボックスをオフにし、[Integrated Windows authentication] が選択されていることを確認して、[OK] をクリックします。 
g. [ContactCenter Properties] ウィンドウで [OK] をクリックします。
h. [<IISSvr>] -> [Web Sites] -> [Default Web Site] の順にクリックし、[ContactCenterAIF] をクリックして、手順 d から g を繰り返します。
i. [<IISSvr>] -> [Web Sites] -> [Default Web Site] の順にクリックし、[AgentCredentials] をクリックして、手順 d から g を繰り返します。
j. [<IISSvr>] -> [Web Sites] -> [Default Web Site] の順にクリックし、[AdminConsoleWS] をクリックして、手順 d から g を繰り返します。
2. 
<UnzipDir>\Others フォルダの CCFTemplates フォルダを IIS マシンの<OSDRIVE>\CCFTemplates へコピーし、IIS マシンで CCFTemplates という仮想ディレクトリを作成して、CCFTemplates フォルダのファイルにアクセスするようポイントします。 この仮想ディレクトリへの匿名アクセスが有効になっていることを確認します。 IIS サーバーで仮想ディレクトリを作成するには、以下の手順に従います。
a. [Start] -> [Program] -> [Administrative Tools] -> [Internet Information Services (IIS) Manager] の順にクリックします。
b. [<IISSvr>] -> [Web Sites] -> [Default Web Site] の順に移動します。
c. [Default Web Site] を右クリックし、[New] -> [Virtual Directory] の順にクリックします。
d. ウィザードで、Alias フィールドに CCFTemplates と入力し、[Next] をクリックします。
e. <OSDRIVE>\CCFTemplates フォルダを参照し、[Next] をクリックします。
f. [Virtual Directory Access Permissions] ページでは設定は変更せず、[Next] をクリックします。
g. [Finish] をクリックします。
h. [Default Web Site] で作成された CCFTemplates 仮想ディレクトリのチェック ボックスをオンにします。
i. [CCFTemplates] を右クリックし、[Properties] をクリックします。
j. [Authentication and Access Control] セクションで [Directory Security] タブをクリックし、[Edit] をクリックします。
k. [Enable Anonymous access] チェック ボックスがオフになっている場合はオンにし、[OK] をクリックします。
l. [CCFTemplates Properties] ウィンドウで [OK] をクリックします。
3. CCF Web サービスすべてのアプリケーション プールを DefaultAppPool から CCFAppPool へ変更します。
1. [Start] -> [Program] -> [Administrative Tools] -> [Internet Information Services (IIS) Manager] の順にクリックします。
2. [<IISSvr>] -> [Web Sites] -> [Default Web Site] の順に移動します。
3. [Default Web Site] で [ContactCenter] をクリックします。
4. 表示されたメニューで右クリックし、[Properties] をクリックします。
5. [Application pool] ボックスで、[CCFAppPool] をクリックします。
6. [OK] をクリックします。
7. 仮想ディレクトリ ContactCenterAIF、AdminConsoleWS、AgentCredentials、および CCFTemplates について手順 3 から 6 を繰り返します。
4. Contact Center Web Services (<wwwrootDir>\ContactCenter) の Web.CONFIG ファイルの appSettings セクションには以下の重要な構成情報が入っています。
· DBConnectionString – パイロット展開では、この文字列は “Server=CCFSQL;Integrated Security=true; Database=ContactCenter; Pooling=false” になります。 SQL Server 名が CCFSQL ではない場合は、正しい SQL Server 名を入力します。
· AddressBook.LDAPPath – パイロット展開では、この文字列は "LDAP://CN=Users,DC=CCF,DC=Demo" になります。 選択された FQDN が異なっている場合は文字列を変更します。
· [<authorization>] セクションで以下の設定を変更します。
<allow roles="CCF\ccfusers" /> で 正しい CCFUsers グループ名になるように変更します。
既定では、<allow roles="CCF\ccfusers" /> になります。 この場合、グループ名 CCF\ccfusers がセクション CCFUsers User Group で作成されたグループになるようサポートされています。
· IIS マシン名が “CCFIIS” ではなく、IIS マシンに DNS ホスト名も作成されていない場合は、アプリケーション キーの値 Microsoft.NSP.SqlSink.EIFLogWS.LogManager を変更します。
http://ccfiis/ContactCenterAIF/LogManager.asmx
この行を次のように変更します。
http://<IISSvr>/ContactCenterAIF/LogManager.asmx
<IISSvr> を IIS マシンの実際のマシン名と置き換えます。
IIS マシン名が “CCFIIS” ではなく、IIS マシンに CCFIIS という DNS ホスト名が作成されている場合は、アプリケーション キーの値 Microsoft.NSP.SqlSink.EIFLogWS.LogManager を変更します。
"http://ccfiis/ContactCenterAIF/LogManager.asmx"
この行を次のように変更します。
http://CCFIIS.ccf.demo/ContactCenterAIF/LogManager.asmx
この場合、CCFIIS.ccf.demo は IIS マシンの完全修飾 DNS 名です。
5. Contact Center AIF Web Services (<wwwrootDir>\ContactCenterAIF) の Web.CONFIG ファイルの appSettings セクションには以下の重要な構成情報が入っています。
· DBConnectionString – パイロット展開では、この文字列は “Server=CCFSQL; Integrated Security=true; Database=ContactCenterAIF; Pooling=false” になります。 SQL Server 名が CCFSQL ではない場合は、正しい SQL Server 名を指定します。
· AzManStore – このキーの値は “msxml:// <wwwrootDir>\ContactCenterAIF\AzManCCF.xml” になります。 
· [<authorization>] セクションで以下の設定を変更します。
<allow roles="CCF\ccfusers" /> で 正しい CCFUsers グループ名になるように変更します。
既定では、<allow roles="CCF\ccfusers" /> になります。 この場合、グループ名 CCF\ccfusers がセクション CCFUsers User Group で作成されたグループになるようサポートされています。
· IIS マシン名が “CCFIIS” ではなく、IIS マシンに DNS ホスト名も作成されていない場合は、アプリケーション キーの値 Microsoft.NSP.SqlSink.EIFLogWS.LogManager を変更します。
http://ccfiis/ContactCenterAIF/LogManager.asmx
この行を次のように変更します。
http://<IISSvr>/ContactCenterAIF/LogManager.asmx
<IISSvr> を IIS マシンの実際のマシン名と置き換えます。
IIS マシン名が “CCFIIS” ではなく、IIS マシンに CCFIIS という DNS ホスト名が作成されている場合は、アプリケーション キーの値 Microsoft.NSP.SqlSink.EIFLogWS.LogManager を変更します。
"http://ccfiis/ContactCenterAIF/LogManager.asmx"
この行を次のように変更します。
http://CCFIIS.ccf.demo/ContactCenterAIF/LogManager.asmx
この場合、CCFIIS.ccf.demo は IIS マシンの完全修飾 DNS 名です。
6. AdminConsole Web Services (“<wwwrootDir>\AdminConsoleWS”) の Web.CONFIG ファイルの appSettings セクションには以下の重要な構成情報が入っています。
· ContactCenterConString – パイロット展開では、この文字列は “Server=CCFSQL; Integrated Security=true; Database= ContactCenter; Pooling=false” になります。 SQL Server 名が CCFSQL ではない場合は、正しい SQL Server 名を指定します。
· ContactCenterAIFConString – パイロット展開では、この文字列は “Server=CCFSQL; Integrated Security=true; Database= ContactCenterAIF; Pooling=false” になります。 SQL Server 名が CCFSQL ではない場合は、正しい SQL Server 名を指定します。
· AzmanStorePath – この設定の値は “msxml://<installation path>\Config\AzManCCF.XML.” になります。これは、“<wwwrootDir>\ContactCenterAIF\AzManCCF.xml” というパスを構成するよう変更する必要があります。
· <authorization> セクションで以下の設定を変更します。
<allow roles="CCF\CCFAdmins" />
既定では、<allow roles="CCF\CCFAdmins" /> になります。 この場合、グループ名 CCF\CCFAdmins がセクション CCFAdmins User Group
 で作成されたグループになるようサポートされています。
注: このパイロット展開では、‘CCF’ は NetBIOS ドメイン名になります。 CCF でない場合は、実際のドメイン名と置き換えます。
7. AgentCredentials Web Services (“<wwwrootDir>\AgentCredentials”) の Web. config ファイルの authorization セクションには以下の重要な構成情報が入っています。 

authorization セクションで以下の設定を変更します。
<allow roles="CCF\ccfusers" /> で 正しい CCFUsers グループ名になるように変更します。
既定では、<allow roles="CCF\ccfusers" /> になります。 この場合、グループ名 CCF\ccfusers がセクション CCFUsers User Group で作成されたグループになるようサポートされています。
CCF データベースのインストール
マシン: <SQLSvr>
ログイン ユーザー: ローカル管理者
CCF-CSR で必要なデータベースをインストールするには、次の操作を行います。
BuildDb2.0.cmd CCF\ASPUSER CCF\CCFAdmins 
CCF SQL Server マシンのコマンド プロンプトで上記を入力し、ContactCenter、ContactCenterAIF、および CCFReports データベースを作成し、適切なアクセス許可を与えます。 
注: 上記のコマンド ラインで CCF は NetBIOS CCF のドメイン名 (<DomainName> など) を表しています。 CCF でない場合は、同等の名前と置き換えます。
BuildDb2.0.cmd は <UnzipDir>\Database\CSR にあります。 フォルダ <UnzipDir>\Database を CCF SQL Server マシンにコピーし、バッチ ファイルを実行します。 バッチ ファイルを実行しているとき、マシンのログイン ユーザーがローカル管理者またはドメイン管理者であることを確認します。
検証
ContactCenter データベース下で作成されたテーブルをチェックするには、以下の手順に従います。
マシン: <SQLSvr>
ログイン ユーザー: ローカル管理者
1. [Start] -> [Programs] -> [Microsoft SQL Server] -> [Enterprise Manager] の順にクリックすると、[Microsoft SQL Servers] アイコンが表示されます。
2. [Microsoft SQL Servers Icon] アイコンをクリックすると、[SQL Server Group] が表示されます。  

3. [<SQLSvr>] ノードをクリックして [Databases] ノードを展開すると、すべてのデータベースの一覧が表示されます。
4. [ContactCenter] データベース ノードを展開します。 

5. [ContactCenter] ノード下の [Tables] ノードをクリックします。 すべての ContactCenter データベース テーブルの一覧が右側のペインに表示されます。
6. 同様に [ContactCenterAIF] データベース ノードを展開し、[Tables] ノードをクリックして、ContactCenterAIF データベース テーブルの一覧を表示します。
監査ログ レポートの構成
CCF SQL Server の構成
BAM モジュールを構成するには、<SQLSvr> マシンで以下の手順に従います。
監査報告用 SQL ジョブの構成
マシン: <SQLSvr>
ログイン ユーザー: ローカル管理者
1. AuditTrailReportGeneration ジョブを実行するには SQL Server エージェントが動作している必要があります。 SQL Server エージェントが停止している場合は起動します。 SQL Server エージェントを起動するには、以下の手順に従います。
a. [Start] -> [Programs] -> [Microsoft SQL Server] -> [Service Manager] の順にクリックします。
b. [Services] ボックスで、[SQL Server Agent] をクリックします。
c. [Start/Continue] をクリックしてサービスを起動します。
2. CCF v2.0 の一部としてインストールされた AuditTrailReportGeneration ジョブが毎週 1 回実行します。
3. このジョブのスケジュールを変更するには、次の操作を行います。
a. SQL Enterprise Manager を開きます。
b. クリックして、ローカルの SQL Server インスタンスを開きます。
c. [Management] フォルダをクリックします。
d. [SQL Server Agent] サブフォルダをクリックします。
e. [Jobs] サブフォルダをクリックします。
f. [AuditTrailReportGeneration] ジョブをダブルクリックします。
g. [Schedules] タブをクリックします。
h. [New Schedule] をクリックするか、既存のスケジュールを開いて時間を変更します。
i. [Apply] をクリックします。
4. ジョブをするに実行するには、次の操作を行います。
a. [AuditTrailReportGeneration] ジョブを右クリックします。
b. [Start Job] オプションをクリックします。
CCFReports ユーザーのアクセス許可の構成
マシン: <SQLSvr>
ログイン ユーザー: ローカル管理者
1. SQL Enterprise Manager を開きます。
2. <SQLSvr> に接続します。
3. <SQLSvr> サーバー ルートで [Security] -> [Logins] の順にクリックします。
4. 右クリックし、[New Login] をクリックします。
5. [SQL Server Login Properties] ウィンドウの [Name] ボックスで、以下のように入力します。
"NT AUTHORITY\ANONYMOUS LOGON".
6. [Defaults] グループで、[Database] ボックスでデータベースに [CCFReports] をクリックします。
7. [Database Access] タブをクリックします。
8. 一覧を下にスクロールして [CCFReports] を見つけます。
9. CCFReports データベースに対応する [Permit] チェック ボックスをオンにします。
10. [database roles] ボックスで [public] ロールをクリックします。
11.  [Properties] をクリックします。
12.  [Permissions] をクリックします。
13.  以下のストアド プロシージャに対して [Exec] オプションのチェック ボックスをオンにします。
a. ShowAgentIdleTimeSummary
b. ShowAgentLoginSummary
c. ShowHostedAppUsagePerAgent
d. ShowHostedAppsSummary
14. [OK] をクリックして開いているウィンドウをすべて閉じます。
CCF SQL Reporting Server の構成
BAM モジュールを構成するには、CCF SQL Reporting マシン (<ReportSvr> など) で以下の手順に従います。
注: 以下のサブセクションで、URL ではサーバー名 CCFRS を使用しています。 CCFRS は <ReportSvr> を表しています。 SQL Reporting Services がインストールされているマシンの名前です。
レポート サーバーでの監査報告フォルダの作成マシン: <ReportSvr>
ログイン ユーザー: ローカル管理者
1. インターネット オプションの [Local Intranet] ゾーンへサイト http://CCFRS を追加します。 これを行うには、以下の手順に従います。
a. [Start] -> [Settings] -> [Control Pane] の順にクリックします。
b. [Internet Options] アプレットを開きます。
c.    [Security] タブに切り替えます。
d. [Local Intranet] ゾーンをクリックします。
e. [Sites] をクリックします。
f.    [Local Intranet] ポップアップ ウィンドウで、[Advanced] をクリックします。
g. [Add this Web Site to the zone] ボックスで http://CCFRS と入力します。
h. [Add] をクリックします。
i.   [Close] をクリックします。
j.   [Internet Options] ウィンドウで [OK] をクリックします。
2. エクスプローラを開き、http://CCFRS/Reports を参照してください。
3. 結果表示されるページで [New Folder] をクリックします。
4. フィールド Name の [New Folder] ページで AuditTrailReports と入力します。
5. [OK] をクリックします。 ホーム ページに戻ります。
6. [AuditTrailReports] ハイパーリンクをクリックします。
7. [New Data Source] をクリックします。
8. データ ソース名として CCFReports と入力します。
9. 以下の接続文字列を入力します。
data source=CCFSQL;initial catalog=CCFReports
注: CCFSQL は CCF SQL Server の名前を表しています。 この名前が CCFSQL でない場合は、適切な CCF SQL Server 名と置き換えます。
10. Windows NT の統合セキュリティをクリックします。
11. [OK] をクリックします。
レポートのアップロード
マシン: <ReportSvr>
ログイン ユーザー: ローカル管理者
1. <OSDRIVE> ドライブで フォルダ CCF-Reports を作成します。
2. *.rdl ファイルを <UnzipDir>\Others\CCFReports から IIS サーバー マシンの <OSDRIVE>\CCF-Reports フォルダへコピーします。
3. SQL Report Server マシン (<ReportSvr>など) でエクスプローラを開き、http://CCFRS/Reports へ移動します。
4. [AuditTrailReports] ハイパーリンクをクリックします。
5. [Upload file] をクリックします。
6. [Browse] をクリックし、[<OSDRIVE>\CCF-Reports\Agent Login Summary Report.rdl] を選択します。
7. [OK] をクリックします。
8. 上記の手順 5 から 7 を繰り返し、<OSDRIVE>\CCF-Reports フォルダにある以下のレポートを読み込みます。
a) Agent Idle Time Summary Report.rdl
b) Hosted Application Summary Report.rdl
c) Hosted Application Usage Per Agent Report.rdl
レポートのセキュリティの構成
マシン: <ReportSvr>
ログイン ユーザー: ローカル管理者
1. IIS サーバーでエクスプローラを開き、http://CCFRS/Reports へ移動します。
2. [Properties] ハイパーリンクをクリックします。
3. [New Role Assignment] をクリックします。
4. [Groups or User Name] ボックスで <DomainName>\CCFAdmins と入力します。 

5. [Browser] オプションをクリックします。
6. [OK] をクリックします。
7. <DomainName>\CCFAdmins グループを CCFReports データベース  dbo グループへ追加します。 これを行うには、以下の手順に従います。
i. SQL Enterprise Manager を開きます。
ii. <SQLSvr> に接続します。
iii. <SQLSvr> サーバー ルートで [Security] -> [Logins] の順にクリックします。
iv. ユーザー グループ [<DomainName>\CCFAdmins] をクリックし、この項目を右クリックします。
v. 表示されたコンテキスト メニューで [Properties] オプションをクリックします。
vi. [Database Access] タブへ切り替えます。
vii. 最初のリスト ビューで [CCFReports] チェック ボックスをオンにします。
viii. 2 番目のリスト ビューで [db_owner] チェック ボックスをオンにします。
ix. [OK] をクリックします。
レポートの表示
マシン: <ReportSvr> または CCF ドメインの他のマシン
ログイン ユーザー: CCFAdmins ドメイン ユーザー グループのメンバ
1. サイト http://CCFRS がインターネット オプションの [Local Intranet] ゾーンへ追加されていることを確認します。 セクション Creating the Audit Reports Folder on Report Server で以下の手順に従います。
2. エクスプローラを開きます。
3. 以下の URL http://CCFRS/Reportserver/AuditTrailReports?%2fAuditTrailReports&rs:Command=ListChildren を参照してください。
注: CCFRS は SQL Reporting Services がインストールされている <ReportSvr> を表します。 CCFRS でない場合は、実際の名前と置き換えます。
4. または http://CCFRS/Reports を参照し、[AuditTrailReports] オプションをクリックします。
注: CCFRS は SQL Reporting Services がインストールされている <ReportSvr> を表します。 CCFRS でない場合は、実際の名前と置き換えます。
5. [Agent Idle Time Summary Report] ハイパーリンクをクリックします。  

6. mm/dd/yyyy 形式で開始日を入力します。
7. [View Report] をクリックします。
レポートに "No Records Found” というメッセージが表示されます。これは、まだレコードが処理されていないことを示しています。 引き続き、SQL ジョブ AudittrailReports が実行され、このレポートがアクセスされるときに、処理されたレコードが表示されます。
クライアント
管理コンソールのインストール手順
マシン: 管理コンソールのクライアント マシン CCF ドメインのマシン (CCFClient1 など) になります。
ログイン ユーザー: ローカル管理者
1. <UnzipDir>\Setup\CSR\Application\AdminConsoleSnapIn\Setup.exe を実行します。
2. [Select Installation Folder] 画面で、オプション [Everyone] をクリックします。 
3. 既定値を設定してセットアップを完了します。
エージェント デスクトップのインストール手順
パイロット セットアップには少なくとも 2 台のクライアント マシンが必要です。 このドキュメントでは、これらのマシンは CCFClient1 および CCFClient2 です。
このマシンのオペレーティング システムは Windows XP 以降になります。 Windows 2000 を使用することもできますが、欠けている機能があり、クライアントの外観も異なっています。 以下の手順は、インストールされているオペレーティング システムが Windows XP であることを前提としています。 

マシン: CCF クライアント マシン
ログイン ユーザー: ローカル管理者
1. Windows XP をインストールし、CCF ドメインに参加します。
2. Windows XP SP2 以降をインストールします。
3. .NET Framework バージョン 1.1 とそれ以降の Service Pack をインストールします。
4. Enterprise Instrumentation Framework をインストールします。 これは現在 http://msdn.microsoft.com/vstudio/enterprise/EIF/ で利用できます。
5. 必要な場合は、Office XP または Office 2003 および Office XP プライマリ相互運用機能アセンブリをインストールします。
これは Office を (CCF デモアプリケーションに必要な) CCF アプリケーションとして使用している場合にのみ必要です。
また、Office Service Pack をインストールする必要があります。これは、Office 2003 ではなく Office XP の場合にのみ必要です。
Office XP アセンブリは以下からインストールします。
http://www.microsoft.com/downloads/details.aspx?familyid=c41bd61e-3060-4f71-a6b4-01feba508e52&displaylang=en
6. CCF2.0 セットアップ パッケージの内容を <UnzipDir> へ抽出します。
7. <UnzipDir>\Setup\CSR\Application\AgentDesktop\Setup.exe を実行します。
8. [Select Installation Folder] ウィザードで、[Everyone] をクリックします。
9. セットアップを完了します。
10. 現在の展開の目的が運用ではなく、CCF のテストまたは今後のカスタマイズ開発のみである場合は、TAPI エミュレータを使用してテレフォニー システムをシミュレーションします。 TAPI エミュレータは、実稼動システムではなく、テスト システム用のみです。 TAPI エミュレータは手動で以下のようにインストールする必要があります。
(実稼動システムの場合は、このプロセスは必要ありません。)
a. ファイル TapiDemo.TSP を <UnzipDir>/Others/Settings ディレクトリから Windows\System32 ディレクトリへコピーします。
b. [Control Panel] から [Phone and Modem Options] アプレットを開きます。
c. このアプレットが最初に開いている場合は、市外局番の入力を促すダイアログ ボックスが表示されます。 住んでいる国の市外局番を入力し、[OK] をクリックします。 
d. アプレットで、[Advanced] タブをクリックします。
e. [追加] をクリックします。
f. [Emulator for TAPI] サービス プロバイダをダブルクリックします。
g. [Tapi Demo SP 0.9] 画面で [OK] をクリックします。
h. [Phone and Modem Options] 画面で [Close] をクリックします。
i. エージェント デスクトップのインストール ディレクトリ <AgentDesktopInstallDir> で SoftPhone.exe を実行します。  このテスト ツールは TAPI エミュレータを使用し、エミュレータが正しくインストールされているかどうか検証します。  H323 やモデムの後に多数の電話デバイスが表示されるはずです。
構成
コード アクセス セキュリティの調整
IIS サーバー マシンからクライアント マシンへとホスト アプリケーションを展開する場合に、コード アクセス セキュリティを調整する必要があります。


マシン: CCF クライアント マシン
ログイン ユーザー: ローカル管理者
1. エクスプローラで、[Tools] -> [Internet Options] -> [Security] -> [Local intranet] -> [Sites] -> [Advanced] の順にクリックし、IIS マシンの名前が CCFIIS の場合は http://ccfiis を追加し、IIS マシンの名前が CCFIIS でない場合は、http://<IISSvr> を追加します (<IISSvr> の部分を IIS サーバーの実際のマシン名と置き換えます)。 
2.  [Start] -> [Settings] -> [Control Panel] の順にクリックし、[Administrative Tools] -> [Microsoft .NET Framework 1.1 Wizards] の順に開き、[Adjust .NET Security] をクリックします。
3. [Make changes to this computer] をクリックし、[Next] をクリックします。
4.  [Local Intranet] をクリックし、信頼性レベルを Full Trust に上げて [Next] をクリックします。
5. [完了] をクリックします。
Windows のファイアウォール構成
マシン: CCF クライアント マシン
ログイン ユーザー: ローカル管理者
Windows XP SP2 で、既定では Windows Firewall が有効になっています。 ファイアウォールは .NET Remoting を使用してエージェント デスクトップの他のコンポーネントと通信するため、エージェント デスクトップのいくつかの機能が無効になります。 .NET Remoting は内部的に TCP ポートをリッスンして着信ネットワーク トラフィックを受信する必要があり、Windows ファイアウォールが既定で有効になっているため、この着信トラフィックはブロックされ、エージェント デスクトップの機能がいくつか無効になります。
この問題を回避するには、エージェント デスクトップ関連の実行可能ファイル間の着信トラフィックを重点的に有効にするよう、Windows ファイアウォールの例外一覧にこれらの実行可能ファイルを含める必要があります。 エージェント デスクトップ関連の実行可能ファイルを Windows ファイアウォールの例外一覧に含める方法は多数存在し、展開環境に応じて適切な方法を使用できます。 これらすべてのアプローチの最終目標は、同じマシンに常駐し、実行する AgentDesktop.exe および AppLauncherExe.exe への着信ネットワーク トラフィックを有効にすることです。
Windows XP SP2 におけるこの CCF パイロット展開 (また実稼動展開) では、Computer Configuration Group Policy を使用して Active Directory (AD) オブジェクトで Windows ファイアウォール関連の設定を展開してください。 このアプローチの利点は、Windows ファイアウォール構成は 1 か所でのみ (また 1 度のみ) 行う必要があり、Windows 2003 ベースの CCF ドメインのすべてのメンバ マシンに自動的に適用されるという点です。
グループ ポリシーを使用して Windows ファイアウォールを構成する手順を以下に示します。 これらの手順はパイロット展開に極めて固有で、Windows XP SP2 マシンにのみ動作します。 展開環境で、企業用ポリシーにあわせるため適宜、手順を変更しなければならない場合があります。 たとえば、以下の手順はドメイン全体の Windows ファイアウォール設定に適用しますが、実稼動環境では AD で新しい組織単位 (OU) を作成し、すべてのエージェントのマシンをグループ化し、これらの設定をその OU へ適用してください。 このトピックの詳細については、資格のあるネットワーク管理者へ問い合わせてください。
グループ ポリシーを使用して Windows ファイアウォールを構成し、エージェント デスクトップ関連実行可能ファイルを例外一覧へ追加するには、以下の手順に従います。
1.  (Windows XP SP2 付き) クライアント マシンの 1 台にドメイン管理者セキュリティ グループのメンバ (現在のコンテキストでは CCF\Administrator) としてログオンします。
2. Windows XP デスクトップで、[Start]、[Run] の順にクリックして mmc を入力し、[OK] をクリックします。
3. [File] メニューで、[Add/Remove Snap-in] をクリックします。
4. [Standalone] タブで、[Add] をクリックします。
5. [Available Standalone Snap-ins] ボックスで、[Group Policy] をクリックし、[Add] をクリックします。
6. [Select Group Policy Object] ダイアログ ボックスで、[Browse] をクリックします。
7. [Browse for a Group Policy Object] ダイアログ ボックスで、[Domains/OUs] タブをクリックし、[Domains, OUs and linked Group Policy Objects] の一覧で [Default Domain Policy] をクリックします。
グループ エージェント コンピュータに作成した特定の OU を参照することもできます。
8. [OK] をクリックします。
9. [Finish] をクリックして [Group Policy] ウィザードを終了します。
10. [Add Standalone Snap-in] ダイアログ ボックスで、[Close] をクリックします。
11. [Add/Remove Snap-in] ダイアログ ボックスで、[OK] をクリックします。
12. コンソール ツリーで、[Computer Configuration]、[Administrative Templates]、[Network]、[Network Connections]、[Windows Firewall]、[Domain Profile] の順にクリックします。 mmc の右側のペインに、Windows ファイアウォール関連のグループ ポリシーの一覧が表示されています。
13. Do not allow exceptions グループ ポリシーの構成: 無効にする必要があります。 これは、クライアント (エージェント) マシンのローカル管理者がエージェントのマシンの [Control Panel] の [Windows Firewall] アプレットで[Don’t allow exceptions] チェック ボックスをオンにできないようにするために必要です。
a. 右側のペインに一覧された [Windows Firewall: Do not allow exceptions] というグループ ポリシーをダブルクリックします。
b. 表示されるダイアログ ボックスで、[Disabled] オプションをクリックし、[OK] をクリックします。
14. Define program exceptions グループ ポリシーの構成: AgentDesktop.exe および AppLauncherExe.exe を追加する必要があります。
a. 右側のペインに一覧された [Windows Firewall: Define program exceptions] というグループ ポリシーをダブルクリックします。
b. 表示される [Windows Firewall: Define program exceptions] ダイアログ ボックスで、[Enabled] オプションをクリックします。
c. [Enabled] オプションをクリックすると有効になる [Show…] をクリックします。
d. 表示される [Show Contents] ダイアログ ボックスで、[Add] をクリックします。
e. 小さな [Add Item] ダイアログ ボックスで、以下の文字列を (間に改行文字を入れずに 1 行で) 入力し、[OK] をクリックします。
%programfiles%\Microsoft\CCF Contact Center Agent Desktop\AgentDesktop.exe:LocalSubnet:Enabled:CCF Agent Desktop
すべてのエージェント マシンの既定の場所にエージェント デスクトップ アプリケーションがインストールされているものとしています。 インストール時にこのパスが異なる場合は、上記の文字列で正しいパスを使用する必要があります。
f. [Show Contents] ダイアログ ボックスで、再度 [Add] をクリックします。 

g. 小さな [Add Item] ダイアログ ボックスで、以下の文字列を (間に改行文字を入れずに 1 行で) 入力し、[OK] をクリックします。
%programfiles%\Microsoft\CCF Contact Center Agent Desktop\AppLauncherExe.exe:LocalSubnet:Enabled:CCF Application Launcher
エージェント デスクトップ アプリケーションのインストール パスがインストール時に異なる場合は、上記の文字列で正しいパスを使用する必要があります。
h. [Show Contents] ダイアログ ボックスで、[OK] をクリックします。
i. [Windows Firewall: Define program exceptions] ダイアログ ボックスで、[OK] をクリックします。
15. すべてのクライアント (エージェント) マシンを再起動するか、各エージェント マシン (これらの設定を行ったマシンを含む) のコマンド プロンプトで gpupdate.exe (パラメータ不要) を実行し、グループ ポリシーを最新の情報に更新し、マシンに適用します。
実稼動環境の展開では、この手順 (クライアント マシンの再起動が好ましい) はネットワーク管理者によりリモートで実行できます。
Web サービスの URL の構成
既定では、(AgentDesktop.exe のアプリケーション構成ファイルにある) AgentDesktop が使用する CCF Web サービスのすべての URL では CCFIIS というサーバー名が付きます。 これは IIS マシンの名前が CCFIIS であるという前提に基づいています。 IIS マシンの名前が CCFIIS ではない場合は、これらの URL のサーバー名を正しい名前に変更してください。 サーバー名を調整するには、以下の手順に従います。
マシン: CCF クライアント マシン
ログイン ユーザー: ローカル管理者
1. ファイル <AgentDesktopInstallDir>\AgentDesktop.exe.config をメモ帳で開きます。
2. DNS ホスト名が IIS マシンに作成されていない場合は、Web サービスの URL で見つかったすべての文字列 “ccfiis” を IIS マシンの実際の名前と置き換えます。
3. DNS ホスト名が IIS マシンに作成されている場合は、Web サービスの URL で見つかったすべての文字列 “ccfiis” を IIS マシンの完全修飾 DNS 名と置き換えます。
4. ファイルを保存して、閉じます。
CCF 設定
(ContactCenter データベースの Options テーブルで利用できる) CCF の一般設定を展開環境に合わせて調整する必要があります。 これを行うには、以下の手順に従います。 使用できるすべての CCF 設定とその意味については Appendix – A を参照してください。
マシン: 管理コンソールのクライアント マシン
ログイン ユーザー: CCFAdmins グループのメンバ
1. TAPI エミュレータを使用している場合 (Agent Desktop Installation Steps セクションの手順 10 を行っている場合) は、CCF の CTIType 設定を行う必要があります。 これを行うには、以下の手順に従います。
a. [Start] -> [Run] の順にクリックします。 mmc と入力します。
b. [File] -> [Add/Remove Snap-in] の順にクリックします。
c. [Add] をクリックし、[CCF Admin Console] をクリックして、[Add] をクリックします。
d. [Close] をクリックします。
e. [Add/Remove Snap-in] ウィンドウで [OK] をクリックします。
f. [Connect…] ダイアログ ボックスが表示されると、<IISSvr> という IIS サーバーのマシン名を入力し、[Connect] をクリックします。
g. [<IISSvr>] ノードを展開します。
h. [<IISSvr>] ノードで [Settings] ノードを展開します。
i. [General Settings] ノードをクリックします。
j. 右側のペインで、[CTIType] アイテムをダブルクリックします。
k. [Value] ボックスで、2 を入力し [OK] をクリックします。
2. IIS サーバーのマシン名が CCFIIS でない場合は、IIS サーバーの実際のマシン名となるように設定 csAppSummaryXSL および csBlankPageURL と関連付けられた URL を変更します。 これを行うには、以下の手順に従います。
CCFIIS という IIS マシンの DNS ホスト名を作成した場合は、この手順をスキップできます。
a. [Start] -> [Run] の順にクリックします。 mmc と入力します。
b. [File] -> [Add/Remove Snap-in] の順にクリックします。
c. [Add] をクリックし、[CCF Admin Console] をクリックして、[Add] をクリックします。
d. [Close] をクリックします。
e. [Add/Remove Snap-in] ウィンドウで [OK] をクリックします。
f. [Connect…] ダイアログ ボックスが表示されると、<IISSvr> という IIS サーバーのマシン名を入力し、[Connect] をクリックします。
g. [<IISSvr>] ノードを展開します。
h. [<IISSvr>] ノードで [Settings] ノードを展開します。
i. [General Settings] ノードをクリックします。
j. 右側のペインで、[csAppSummaryXSL] アイテムをダブルクリックします。
k. [Value] ボックスに存在する URL で、ccfiis を IIS サーバーの実際のマシン名と置き換えます。
注: DNS ホスト名が作成された IIS マシンの場合は、ccfiis を IIS マシンの DNS ホスト名と置き換えることができます。
l. [OK] をクリックします。
m. 項目 csBlankPageURL にも手順 j から l を繰り返します。
検証
アプリケーションが完全に正しくインストールされたことを検証するには、最小限のデータ量がシステムで使用できなければなりません。 管理コンソールは少数 (最低でも 1 つ) エージェントを CCF へ追加するのに使用できます。
AD におけるエージェントを表すドメイン ユーザーの作成
マシン: <DomainController>
ログイン ユーザー: ドメイン管理者
CCF\DemoAgent1、CCF\DemoAgent2、CCF\CSRAgent、CCF\DemoAdmin、および CCF\SKTIAgent というユーザー名を持つ新規ユーザーを CCF ドメインで作成します。これを行うには、ASPUSER User Account セクションの手順 1 から 5 を繰り返します。 CCF はドメインの NetBios 名で、アカウント名はインストールを検証し、メイン CCF パッケージで提供されたデモ パッケージ (セクション CCF Demo Applications を参照) を使用するのに必要なデモ ユーザーのみです。いずれにしても、検証担当者は異なるユーザー名を自由に選択できます。 しかし、デモ パッケージは上記ユーザー名でデータベースへレコードを挿入するため、デモパッケージを正しく動作させるには、指定した名前を使用します。
1. 上記の手順で作成されたユーザーの電話番号を指定します。 以下の手順に従います。
a. [Start] -> [Program] -> [Administrative Tools] -> [Active Directory Users and Computers] の順にクリックします。
b. [<CCFFQDN>] でノード [Users] をクリックします。
c. [CCF\DemoAgent1] (または同等のノード) をダブルクリックします。
d. Telephone Number フィールドにエージェントの電話番号を入力します。 エージェントはこの電話番号で顧客からの電話を受けます。
e. [OK] をクリックします。
f. ユーザー CCF\DemoAgent2、CCF\CSRAgent、CCF\DemoAdmin、CCF\SKTIAgent (または同等のユーザー) に対して手順 c から e を繰り返します。
2. 上記で作成したユーザーをドメイン ユーザー グループ CCFUsers に追加します。
a. [<CCFFQDN>] ノードの [Users] オブジェクトをクリックします。
b. 右側のペインの [CCFUsers] アイテムをダブルクリックします。
c. [Members] タブをクリックします。
d. [Add] をクリックし、手順 1 で作成したユーザーを選択します。
エージェントを CCF へ追加するための管理コンソールの使用
マシン: 管理コンソールのクライアント マシン
ログオン ユーザー: <CCFAdminAcct> またはグループ CCFAdmins の一部であるユーザー
1. [Start] -> [Run] の順にクリックします。 mmc と入力します。
2. [File] -> [Add/Remove Snap-in] の順にクリックします。
3. [Add] をクリックし、[CCF Admin Console] をクリックして、[Add] をクリックします。
4. [Connect…] ダイアログ ボックスが表示されると、<IISSvr> という IIS サーバーのマシン名を指定し、[Connect] をクリックします。
5. [Close] をクリックします。
6. [Add/Remove Snap-in] ウィンドウで [OK] をクリックします。
7. [<IISSvr>] ノードを展開します。
8. [<IISSvr>] でノード [Agents] をクリックします。
9. 右側のペインで空白を右クリックします。
10. コンテキスト メニューで [New] -> [Agents…] の順にクリックします。
11. ウィザードのようこそ画面で、[Next] をクリックします。現在の画面で、ユーザーの名前と苗字をそれぞれ Demo および Agent と入力します。Domain User フィールドで、アカウント名 CCF\DemoAgent1 (または前のセクションで作成されたアカウント名) を入力します。
12. [Next] をクリックします。
13. 最後の画面が表示されるまで [Next] をクリックします (または、[Finish] ではなく [Next] をクリック)。最後の画面で [Finish] をクリックします。
14. コンソールの右側のペインに新規エントリが追加されていることを検証します。
注: 管理コンソールを使用していない場合は、Appendix - B を参照してください。
CCF サーバーの検証手順マシン: (エージェント デスクトップがインストールされている) クライアント マシン
ログイン ユーザー: CCF\DemoAgent1 (上記の「AD におけるエージェントを表すドメイン ユーザーの作成」セクションで作成された同等のユーザー名)
1. 注: 以下に指定した URL では、CCFIIS は CCF IIS マシンの NetBIOS マシン名 (<IISSvr>) を表しています。 DNS ホスト名が IIS マシンに作成されている場合は、DNS ホスト名を IIS マシンの完全修飾 DNS 名と置き換えます。http://CCFIIS を [Internet Options] の [Security] タブの [Local Intranet] サイトへ追加します。
2. エクスプローラを使用して、http://CCFIIS/ContactCenter/AddressBook.asmx?op=GetAddresses へ移動します。
3. prefix の値 (例: A) および howMany の 値 (例: 5) を入力し、[Invoke] をクリックします。 クエリーの結果は XML に表示されます。
4. エクスプローラを使用して、http://ccfiis/ContactCenterAIF/Application.asmx?op=GetApplications
 へ移動します。
5. [Invoke] をクリックします。 クエリーの結果は XML に表示されます。たとえば、現在のログイン ユーザーに構成されているアプリケーション一覧に表示されます。 この時点の展開では、まだホスト アプリケーションを構成していないため、空の一覧が表示される場合があります。
エージェント デスクトップの検証手順
マシン: (エージェント デスクトップがインストールされている) クライアント マシンログイン ユーザー: CCF\DemoAgent1 (上記の「AD におけるエージェントを表すドメイン ユーザーの作成」セクションで作成された同等のユーザー名)
1. エージェント デスクトップ アプリケーションを起動します。
2. エージェント デスクトップがエラー メッセージを表示せずに開くことを検証します。
システムの起動をするデモ アプリケーションをインストールするには、セクション CCF Demo Packages を参照してください。
リモート クライアントの展開
CCF 管理者はクライアント マシンにリモートでエージェント デスクトップをインストールできます。 以下この実行方法を説明します。前提条件
1. System Management Server 2003 サーバーがマシンにインストールされている。
2. SMS サイトが配布ポイントとして構成されており、CCF ドメインで使用できるコンピュータを検出でき、ソフトウェアの配布の準備ができている。
3. すべてのクライアント マシンに SMS クライアント ソフトウェアがインストールされており、SMS エージェントが上記の SMS サーバーから配布されたソフトウェア パッケージを受信し、割り当てられたプログラムを実行する準備ができている。
重要:
マシン: SMS サーバーがインストールされているマシン
ログイン ユーザー: ドメイン管理者
1. Advertisement 通知が SMS クライアント エージェントに対して無効になっていることを確認します。 これを行うには、以下の手順に従います。
a. [Microsoft System Management Server management console] スナップインを開きます。
b. [Site Hierarchy] ノードを展開します。
c. サイト名に対応した子ノードを展開します。
d. [Site Settings] 子ノードを展開します。
e. [Client Agents] 子ノードをクリックします。
f. 右側で、[Advertised Program Client Agents] をクリックします。
g. 右クリックし、[Properties] をクリックします。
h. 正しいページが表示されたら、[New program notification icon opens Add or Remove Programs] オプションのチェック ボックスをオフにします。
i. [Notification] タブに切り替えます。
j. チェック ボックス [Provide a countdown] がオフにされているはずです。 このオプションが有効になっている場合は、無効にします。
k. [OK] をクリックします。
2. ソフトウェアの配布がクライアントに有効になっていることを確認します。 これを行うには、以下の手順に従います。
a. [Microsoft System Management Server management console] スナップインを開きます。
b. [Site Hierarchy] ノードを展開します。
c. サイト名に対応した子ノードを展開します。
d. [Site Settings] 子ノードを展開します。
e. [Client Agents] ノードをクリックします。
f. 右側のパネルの [Right-click the Advertised Programs Client Agent] アイテムを右クリックし、[Properties] をクリックします。
g. [Enable software distribution to clients] チェック ボックスがオンになっていることを確認します。
h. [OK] をクリックします。
3. サイト システムが配布ポイントとして構成されていることを確認します。 これをチェックするには、以下の手順に従います。
a. [Microsoft System Management Server management console] スナップインを開きます。
b. [Site Hierarchy] ノードを展開します。
c. サイト名に対応した子ノードを展開します。
d. [Site Settings] 子ノードを展開します。
e. [Site Systems] ノードをクリックします。
f. 右側のペインで、[SMS server system] アイテムを右クリックし、コンテキスト メニューで [Properties] をクリックします。
g. [Distribution Point] タブに切り替えます。
h. [Use this system as a Distribution point] チェック ボックスがオンになっていることを確認します。
i. [OK] をクリックします。
エージェント デスクトップのインストール
マシン: SMS サーバーがインストールされているマシン
ログイン ユーザー: ドメイン管理者
1. SMS で新規コレクションを作成することで、エージェント デスクトップをインストールするクライアント マシンを選択します。
a. System Management Server 管理コンソールを開きます。
b. [Site Database] ノード下に存在する [Collection] というノードをクリックします。
c. 右クリックして、[New] -> [Collection] の順にクリックします。
d. 表示された [Collection Properties] ダイアログで、[Name] ボックスのコレクション名に CCF Clients を入力します。
e. [Membership Rules] タブへ切り替えます。
f. [image: image4.png]


 をクリックします。 ようこそ画面で [Create Direct Membership Rule] ウィザードが起動したら、[Next] をクリックします。
g. [Resource class] ボックスで [System Resource] をクリックします。
h. [Attribute Name] ボックスで、アイテム [Name] をクリックします。
i. 値に % というワイルドカード文字を使用して、目的のクライアント マシン名すべての一覧と一致する適切な値を Value フィールドに指定します。
例 : 
Value フィールドに文字列 ccfclient% を入力します。 値は名前が文字列 ccfclient で始まるすべてのクライアント マシンと一致します。 前述の例では、ccfclient1、ccfclient2、ccfclient3 などすべてのクライアント マシン名と一致します。
j. [Next] をクリックします。
k. もう一度 [Next] をクリックして、現在のページをスキップします。
l. [Resource] に一覧表示された各マシン名に対して有効なチェック ボックスをオンにします。 エージェント デスクトップをインストールするのにスキップするマシンがある場合は、そのマシンのチェック ボックスをオフにしたままにします。
m. [Next] をクリックし、[Finish] をクリックしてウィザードを終了します。
n. [Collection Properties] ダイアログ ボックスで [OK] をクリックします。
o. Select the [Collections] ノードをクリックし、F5 キーを押して最新の状態に更新します。 新規コレクション CCF Clients が一覧表示されていることを確認します。左側の [CCF Clients] ノードをクリックし、エージェント デスクトップのセットアップ対象となるすべてのクライアント マシンの一覧を確認します
2. エージェント デスクトップのセットアップ ファイルを SMS マシンのフォルダへコピーします。
例 : 
Agent Desktop Setup files フォルダを SMS マシンの以下の場所へコピーします。
E:\SMS\DataSources\CCF
3. SMS で、エージェント デスクトップ セットアップの新規配布パッケージを作成します。
a. SMS 管理コンソールで、サイト データベースの [Packages] ノードをクリックします。
b. 右クリックして、[New] -> [Package] の順にクリックします。 [Package Properties] ダイアログ ボックスが開きます。
c. [General] タブで、Name フィールドでパッケージ名に AgentDesktop を入力します。
d. Version フィールドに、エージェント デスクトップのバージョン (2.0 など) を入力します。
e. [Data Source] タブへ切り替えます。
f. [This package contains source files] チェック ボックスをオンにします。
g. [Set] をクリックします。
h. [Set Source Directory] ダイアログ ボックスが表示されたら、[Local drive on site server] をクリックします。ローカル マシン (SMS マシン) でエージェント デスクトップ セットアップ ファイルが保存されているディレクトリの場所を入力します。
例 : 
E:\SMS\DataSources\CCF
i. [Set Source Directory] ダイアログ ボックスで [OK] をクリックします。 [Package Properties] ダイアログ ボックスへ戻ります。
j. [Distribution Settings] タブをクリックし、[Sending Priority] の [High] をクリックします。
k. [OK] をクリックします。
l. SMS 管理コンソールのスコープ ツリーで、[Packages] ノードの [Agent Desktop 2.0] ノードを展開します。 [Access Accounts]、[Distribution Points]、および [Programs] で一覧表示された 3 つの項目が確認できます。
m. [Agent Desktop 2.0] ノードの [Programs] ノードをクリックします。
n. 右クリックして、[New] -> [Program] の順にクリックします。 [Program Properties] ダイアログ ボックスが表示されます。プログラムの名前に Agent Desktop を入力します。
o. Command line フィールドに以下のコマンドを入力します。
msiexec.exe /q ALLUSERS=2 /i “Agent Desktop Setup.msi” /La “C:\AgentDesktop_Install.log”
注: 既定のインストール パスは以下のとおりです。
C:\Program Files\Microsoft\CCF Contact Center Agent Desktop
エージェント デスクトップ ソフトウェアを他のパスにインストールする必要がある場合は、Command line フィールドに以下のコマンドを入力します。
msiexec.exe /q ALLUSERS=2 /i “Agent Desktop Setup.msi” TARGETDIR=<パス> /La “C:\AgentDesktop_Install.log” 



<パス> を必要なインストール パスと置き換えます。
p. [Environment] タブに切り替えます。
q. [Program can run] ボックスで [Whether or not a user is logged on] オプションをクリックします。
r. [Advanced] タブに切り替え、[Suppress program notifications] チェック ボックスをオンにします。
s. [Windows Installer] タブに切り替え、[Import] をクリックしてファイル ブラウザ ウィンドウを開き、ファイル [Agent Desktop Setup.msi] を選択して、[Open] をクリックします。
t. [Program Properties] ダイアログ ボックスで [OK] をクリックします。
4. エージェント デスクトップ セットアップ パッケージを配布し、クライアントにインストールします。
a. SMS 管理コンソールで [Packages] ノードの [Agent Desktop 2.0] をクリックします。
b. 右クリックして、[All Tasks] -> [Distribute Software] の順にクリックします。 [Distribute Package] ウィザードを起動します。
c. ようこそページで [Next] をクリックします。
d. 配布ポイント一覧に表示されている 1 つまたは複数の配布ポイントをクリックします。
e. [Next] をクリックします。
f. [Next] をクリックして現在のページをスキップします。
g. 現在のページで、プログラム Agent Desktop が選択されていることを確認します。 [Next] をクリックします。
h. コレクションを選択するには、[Browse] をクリックします。 [Browse Collections] ダイアログ ボックスが表示されます。
i. [Collections] ツリー ビューでコレクション CCF Clients をクリックし、[Browse Collections] ダイアログ ボックスで [OK] をクリックします。
j. ウィザードで [Next] をクリックします。
k. [Next] をクリックして現在のページをスキップします。
l. コレクション CCF Clients がコレクション一覧に表示されていることを確認します。 [Next] をクリックします。
m. 現在のウィザード ページ ([Advertisement Schedule] 画面) で、今後このパッケージを配布し、エージェント デスクトップをインストールする必要がある時間を指定します。 なるべく現在の時間より 15 分あいだをあけた時間を指定してください。
n. [Next] をクリックします。
o. 現在のページ ([Assign Program] 画面) で、[Yes] をクリックします。 [Assign the program] をクリックします。
p. Assign After フィールドに [Available After] 時間より長い時間を指定します。 [Available After] と [Assign after] の間はなるべく 15 分間あけてください。
q. [Next] をクリックします。
r. [Finish] をクリックし、ウィザードを終了します。
s. ウィザードで指定された [Assign after] の時間直後に、すべてのクライアントでエージェント デスクトップが起動します。
エージェント デスクトップの修復
マシン: SMS サーバーがインストールされているマシン
ログイン ユーザー: ドメイン管理者
1. エージェント デスクトップを修復するクライアント マシンのセットがエージェント デスクトップのインストールで作成および使用されるコレクションと正確に一致していない場合は、前のセクション (エージェント デスクトップのインストール) の手順 1 の指示に従って、異なる名前で新規コレクションを作成します。
2. セクション Installing Agent Desktop の手順 3 の指示に従って、異なる名前で新規パッケージを作成します。
3. (プログラムのコマンドを入力するときに) 手順 3.r で、そのセクションで説明したコマンドではなく、以下のコマンドを入力します。
msiexec.exe /q ALLUSERS=2 /f “Agent Desktop Setup.msi” /La “<OSDrive>\AgentDesktop_Repair.log”
注:
TARGETDIR オプションを使用してエージェント デスクトップをインストールするときに異なるインストール パスを指定した場合は、以下のコマンドを指定します。
msiexec.exe /q ALLUSERS=2 /f “Agent Desktop Setup.msi” /La “<OSDrive>\AgentDesktop_Repair.log” TARGETDIR=<パス>

<パス> を、エージェント デスクトップがインストールされているパスと置き換えます。
4. 前のセクションの手順 4 の指示に従って、新しく作成されたプロジェクトを配布します。 最初の手順で作成されている場合は、新しく作成されたコレクションを選択します。
エージェント デスクトップを修復する必要があるクライアントを選択するために新規コレクションが作成されている場合は、前のセクションの手順 4.i に従って新しく作成されたコレクションを選択します。
エージェント デスクトップのアンインストール
マシン: SMS サーバーがインストールされているマシン
ログイン ユーザー: ドメイン管理者
1. エージェント デスクトップをアンインストールするクライアント マシンのセットがエージェント デスクトップのインストールで作成および使用されるコレクションと正確に一致していない場合は、セクション Installing Agent Desktop の手順 1 の指示に従って、異なる名前で新規コレクションを作成します。
2. セクション Installing Agent Desktop の手順 3 の指示に従って、異なる名前で新規パッケージを作成します。
(プログラムのコマンドを入力するときに) 手順 3.r で、以下のコマンドを入力します。
msiexec.exe /q /x “Agent Desktop Setup.msi” /La <OSDrive>\AgentDesktop_Uninistall.log"
TARGETDIR オプションを使用してエージェント デスクトップをインストールするときに異なるインストール パスを指定した場合は、以下のコマンドを入力します。
msiexec.exe /q /x “Agent Desktop Setup.msi” /La "<OSDrive>\AgentDesktop_Uninistall.log" TARGETDIR=<パス>

<パス> を、エージェント デスクトップがインストールされているパスと置き換えます。
3. 新しく作成したコレクションが最初の手順で作成されている場合はそれを選択することで、前のセクションの手順 4 の指示に従って新しく作成されたプロジェクトを配布します。
単一マシン開発環境の注意事項
すべてのアプリケーション層 (クライアント、Web サービス、およびデータベース) は Windows 2003 SP1 Server または Windows XP SP2 システムで単一コンピュータにインストールできます。
CCF ソース コードにフル アクセスする場合は、<UnzipDir>\UserDocuments フォルダにある CCFv2.0 Developer's Guide.doc に指示があります。
CCF の旧バージョンのアップグレード
CCF v2.0 は CCF v1.02 からアップグレードできます。
1. CCF ドメインですべての設定が行われているかどうか確認します。 セクション Domain Controller を参照してください。
2. 旧バージョンのエージェント デスクトップのアンインストール:
マシン: エージェント デスクトップがインストールされている各クライアント マシン
ログイン ユーザー: ローカル管理者
a. [Control Panel] で [Add/Remove Programs] にアクセスして、Contact Center Agent Desktop をアンインストールします。
3. 旧バージョンの CCF Web サービスのアンインストールと新しい CCF Web サービスのインストール:
マシン: <IISSvr>
ログイン ユーザー: ローカル管理者
a. ContactCenterAIF Web サービス (<wwwrootDir>\ContactCenterAIF フォルダ) のインストール パスにあるファイル AzmanCCF.xml を別の場所にコピーします。 

b. Uninstall the Web サービス “Contact Center Framework – AIF Web Services” および “Contact Center Framework – Web Services” をアンインストールします ([Control Panel] の [Add/Remove programs] を使用して Web サービスを削除します)。
c. セクション CCF Web Services Installation の指示に従って、CCF v2.0 Web サービスをインストールします。
注: Web サービスの web.config ファイルにある構成は保存されません。
d. 手順 3 で保存されている AzmanCCF.XML ファイルを <wwwrootDir>\ContactCenterAI へコピーします。
4. CCF データベースの移行:
マシン: <SQLSvr>
ログイン ユーザー: ローカル管理者
b. コマンド プロンプトを開き、フォルダ UnzipDir>\Database\CSR を見つけます。
c. コマンド プロンプトでコマンド “MigrateToCCF2_0.cmd CCF\CCFAdmins” を実行します。 CCF\CCFAdmins は CCFAdmins User Group セクションで作成されたドメイン グループです。 CCF\CCFAdmins が指定したグループではない場合は、同等のグループと置き換えます。
5. CCF クライアント マシンに CCF v2.0 をインストールするには、Clients セクションの手順に従います。
CSRのアンインストール
Web サービスのアンインストール
CSR Web サービスをアンインストールするには、以下の手順に従います。
マシン: <IISSvr>
ログイン ユーザー: ローカル管理者
1. IIS サーバー マシンで、[Start] -> [Programs] -> [Control Panel] -> [Add or Remove Programs] の順にクリックします。
2. [CCF ContactCenter Web Services] をクリックして、[Remove] をクリックします。
3. CCF ContactCenterAIF Web Services、CCF AgentCredentials Web Services、および CCF AdminConsole Web Services に対して手順 2 を繰り返します。
4. 以下の手順に従って、仮想ディレクトリを削除します。
a. [Start] -> [Program] -> [Administrative Tools] -> [Internet Information Services (IIS) Manager] の順にクリックします。
b. [<IISSvr>] -> [Web Sites] -> [Default Web Site] -> [ContactCenter] の順に移動します。
c. [ContactCenter] を右クリックして、[Delete] をクリックします。
d. ContactCenterAIF、AgentCredentials、AdminConsoleWS 仮想ディレクトリを削除するには、手順 b および c を繰り返します。
クライアントのアンインストール
マシン: エージェント デスクトップをがインストールされており、アンインストールする必要がある CCF クライアント マシン
ログイン ユーザー: ローカル管理者
CSR クライアント アプリケーションをアンインストールするには、以下の手順に従います。
1. CCF クライアント マシンで、[Start] -> [Programs] -> [Control Panel] -> [Add or Remove Programs] の順にクリックします。
2. [CCF Contact Center Agent Desktop] をクリックして、[Remove] をクリックします。
3. CCF 管理コンソール クライアントに対して手順 2 を繰り返します。
トラブルシューティング


ワークフロー
	問題
	原因
	ソリューション

	現在のワークフロー制御が常に無効になっており、何も存在しません。
	AgentWorkflowACL テーブルがこのエージェントに構成されていません。
	管理者は CCF SQL Server のContactCenterAIF データベースにある、このエージェント ID とワークフロー ID を持つ AgentWorkflowACL テーブルを更新する必要があります。 同様のことを行うには、管理コンソール アプリケーションを使用します。

	“Pending workflow for this session is not available. Please contact the administrator”.というエラー メッセージが表示されます。 このエラーが発生する原因は何でしょうか。
	エージェントが、保留中のワークフローのワークフロー ID に対応するワークフローにアクセスしていません。
	管理者は CCF SQL Server のContactCenterAIF データベースにある、このエージェント ID とワークフロー ID を持つ AgentWorkflowACL テーブルを更新する必要があります。同様のことを行うには、管理コンソール アプリケーションを使用します。


カレント セッション
	問題
	原因
	ソリューション

	"An error has occurred while fetching the blank page URL. The application will use IE about: blank." というエラーが発生します。
	空白ページの URL のオプションを照会するのにエージェント デスクトップが SQL Server と通信することができない場合に発生します。
以下の原因により発生する場合があります。
(a) SQL Server との通信の際のネットワークの問題
(b) SQL Server 自体が使用できない。
(c) SQL Server での ASPUSER に対するアクセス拒否
(d) SQL Server の HOSTS ファイルのエントリが正しくない。
(e) 名前 <SQLSvr> が解決されていない。
(f) Web サービスの障害
	これを解決するには、次の操作を行います。
SQL が存在していることを確認する。
<DomainName>\ASPUSER がアクセスされている。
ホスト ファイルが SQL マシンおよび IIS マシンに正しくマッピングしている。
IIS が正しく接続されている。

	"Error in web service while fetching XSL URL. The Current Session pane will not refresh." というエラーが発生します。
	 XSLの URL のオプションを照会するのにエージェント デスクトップが SQL Server と通信することができない場合に発生します。
以下の原因により発生する場合があります。
(a) SQL Server との通信の際のネットワークの問題
(b) SQL Server 自体が使用できない。
(c) SQL Server での ASPUSER に対するアクセス拒否
(d) SQL Server の HOSTS ファイルのエントリが正しくない。
(e) 名前 <SQLSvr> が解決されていない。
(f) Web サービスの障害
	これを解決するには、次の操作を行います。
SQL が存在するか確認する。
<DomainName>\ASPUSER がアクセスされている。
ホスト ファイルが SQL マシンおよび IIS マシンに正しくマッピングしている。
IIS が正しく接続されている。

	Softphone.exe を実行すると、以下のエラーが発生します。
“Unhandled exception: COM object with CLSID{..} is either not valid or not registered.”
	 ファイル <AgentDesktopInstallDir>\CTILayerTapi.ocx および <AgentDesktopInstallDir>\CTILayerTsapi.ocx の登録ができませんでした。
	ファイルを再度登録してください。 以下の手順に従います。
a. [Start] -> [Run] の順にクリックします。
b. コマンド regsvr32 <AgentDesktopInstallDir>\ CTILayerTapi.ocx を入力します。
c. [OK] をクリックします。
d. ファイル CTILayerTsapi.ocx に対して手順 1 から 3 を繰り返します。


一般
	問題
	原因
	ソリューション

	単一マシン環境 (サーバーおよびクライアントがすべて単一の Win2k3 SP1 マシンにインストールされている) で、エージェント デスクトップを開いているときに、“Unable to contact web server” in the details you see “401: Unauthorized” というエラーを受信します。
	Windows 2003 SP1 にはループバック チェック セキュリティ機能関連のバグがあります。 詳細については、http://support.microsoft.com/default.aspx?scid=kb;en-us;896861 を参照してください。
	ループバック チェック セキュリティ機能をオフにします。 以下の手順に従います。
a. [Start]、[Run] の順にクリックし、regedit を入力して [OK] をクリックします。 

b. レジストリ エディタで、以下のレジストリ キーを見つけ、クリックします。
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Lsa 
c. [Lsa] を右クリックし、[New] をポイントして、[DWORD Value] をクリックします。 

d. DisableLoopbackCheck と入力し、ENTER キーを押します。 

e. [DisableLoopbackCheck] を右クリックし、[Modify] をクリックします。 

f. [Value] ボックスで、1 と入力し [OK] をクリックします。 

g. レジストリ エディタを終了して、コンピュータを再起動します。
重要: これは単一マシン環境に固有であり、複数マシン環境ではほとんど発生しません。 この修正は実稼動展開環境にはお勧めしません。複数マシン環境で試してみる場合は、ローカル管理者でログインし、<IISSvr> マシンおよび <ReportSvr> マシンで上記の手順を行います。


CCF1.02 から CCF2.0 への移行
	問題
	原因
	ソリューション

	CCF1.02 から CCF2.0 へ移行した後、ホスト アプリケーション ノードでアプリケーションを選択すると、管理コンソールでエラーが表示されます。
	CCF IIS サーバー マシンで ContactCenterAIF データベースの Application テーブルにあるエントリと <wwwrootDir>\ContactCenterAIF のAzmanCCF.xml にあるエントリが同期していません。 
	(存在しない場合は) ContactCenterAIF データベースの Application テーブルの各行について、CCF IIS サーバー マシンで AzmanCCF.xml を構成します。

	承認マネージャを使用してアプリケーションを構築しているとき、“Cannot open the authorization store. The following problem occurred: Class not registered” というエラーが発生します。
	CCF1.02 から CCF2.0 へアップグレードするときに、たとえば azroles.dll といった承認マネージャのバイナリが登録されないことがあります。
	[Start] -> [Run] の順にクリックします。
regsvr32 <OSDRIVE>\WINDOWS\system32\azroles.dll を入力し、[OK] をクリックします。
このコマンドは azroles.dll を登録します。


セキュリティの考慮事項
このセクションは、CSR に関連したセキュリティの考慮事項および CSR モジュールを使用する場合に発生する可能性のあるセキュリティ問題の回避方法について説明します。
1. CCF の一部として構成された各ホスト アプリケーションは購入または社内で開発できたかもしれませんが、CCF がコール センターにもたらされる前に作成されたようです。 これらの場合、セキュリティ問題が存在 (または存在しない) する場合がありますが、これらの問題は CCF ではなく、特定のアプリケーションの一部です。
2. 基本的なセキュリティ技法は、エージェントが必要な情報にのみアクセスを許可することです。 たとえば、請求書作成アプリケーションでは、顧客に対応しているときにエージェントが使用を許可されている情報のみ表示させるようにしなければなりません。 クレジット カードの番号やパスワードなどエージェントが必要としない特定の情報が存在する場合は、それは表示させないようにします。
3. エージェントのマシン上の ACL である EnterpriseInstrumentation.config file (<AgentDesktopInstallDir>) は <DomainName>\CCFUsers グループに対する “読み取り” アクセス許可およびインストーラへの “フル” アクセス許可を持っています。
4. すべてのマシンは最新の修正プログラムで更新してください。
5. さらに、クライアント デスクトップを制限するようにしてください。 クライアント デスクトップを制限する手順は、以下に限りません。
· エージェントはデスクトップ システムに対して使用権のみ持っています。
· エージェントはシステムに新しくソフトウェアをインストールする権利はありません。
· エージェントのシステムはファイアウォールの背後で動作している必要があります。エージェントはエクスプローラへのアドインを変更できません。
· エージェントはレジストリへの書き込みアクセス権はありません。
6. すべての Web サービスの HTTP Get および Post アクセスを無効にしてください。 SOAP アクセスのみ有効にします。 これは Web サービスの web.config で設定できます。
7. 金融および証券業界では一般的な、コンタクト センターが回線上で情報を暗号化する必要がある場合は、すべての CCF Web サービスおよびデータベース接続に SSL を使用してください。
8. エージェントはコンタクト センターで信頼された事業体とみなされており、そのために以下のセキュリティ問題は CCF2.0 で取り上げられていません。
a. エージェントは顧客情報を他人に開示しません。 

b. エージェントは信頼されており、CCF システムで悪意ある活動が発生することは想定していません。
c. エージェントは AgentDesktop.exe.config で Web サービス URL を変更しません。
何らかの理由で上記の想定が実装に有効でない場合は、以下のようにしてください。
a. クラスまたはメソッド レベルでコード アクセス セキュリティを使用します。 必要な場合はアセンブリ レベルでの高度なセキュリティ アクセス許可で十分です。 

また、コンタクト センターは以下のセキュリティ対策を施していると想定しています。
a. Web サーバーおよび Database サーバーへの物理的なアクセスは、カード アクセス キーによりセキュリティで保護されたサーバー ルームを通して制限します。
b. ASP ユーザー アカウントおよび CCF ユーザー グループは削除しません。
c. CCF ドメイン管理者は、ドメイン ユーザーに強力なパスワードを設定します。
d. Windows セキュリティは、エージェントおよび管理者以外のユーザーによる CCF クライアントおよびサーバー マシンへのアクセスを禁止するのに十分です。
e. CCF はコンタクト センターの社内ネットワークにインストールされ、外部からこのネットワークにはアクセスしません。
顧客のセルフ サービス ポータル
CSS は CSS ポータルおよびそれにより必要なコンポーネントで構成されています。 

以下のダイアグラムは、CSS ポータルの基本的な展開環境を示しています。
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図 3: CSS ポータルのパイロット環境
CSR ポータルのインストール順序は以下のとおりです。
· ドメイン コントローラ
· SQL Server
· IIS サーバー
展開環境の設定
CSS ポータルのパイロット展開には 5 台のマシンが必要です (企業のネットワークが上記展開環境のように設定されていることを前提としています)。
1. <CSSWebServer>: CSS ポータルの Web ページおよび Configuration Management Server をホストしているマシン。 これは <DomainName> ドメインに存在します。
2. <IISSvr>: CSS ポータル関連の Web サービスをホストしているマシン。 これも CCF ドメインに存在します。 これは CCF の同一 IIS サーバーの場合があります。
3. <SQLSvr>: CSS ポータルの SQL DB を持つマシン これも CCF ドメインに存在します。 これは CCF の同一 SQL Server の場合があります。
4. <DomainController>: CCF ドメインのドメイン コントローラとして動作するマシン。 上記の他のマシンはすべてこのドメインの一部です。 CSS を同一の CSR 環境にインストールする場合は、これは CCF の同一ドメイン コントローラになる場合があります (上記「顧客サービス担当者アプリケーション (エージェント デスクトップ)」セクションを参照)。
5. クライアント マシン: CSS ポータルにアクセスするためのものです。 このマシンは外部環境にあります。
環境設定の担当者は、必要に応じてマシン名およびドメイン名を変更できます。 その場合、このドキュメントで上記の名前の付いたこれらのマシンを参照する場合は必ず、選択した名前を使用してください。上記図 3 の展開アーキテクチャ ダイアグラムで示されたパイロット展開について説明します。
1. 顧客のマシンはインターネット上で Web サイトを参照できます。
2. Web サーバー <CSSWebServer> は NATing デバイスおよびファイアウォールの役割をしているネットワーク デバイス経由で仮想サーバーとしてインターネットに公開されています。 ネットワーク デバイスはポート 80 および 443 (HTTP および HTTPS ポート) でのみ内向き TCP トラフィックを有効にし、ネットワーク アドレス変換後にそのトラフィックを <CSSWebServer> へ送信します。
3. マシンのインターネットへのゲートウェイとしての役割も果たすネットワーク デバイスには、外部インターネット IP アドレスが 1 つあります。 顧客にとっては、これはCSS ポータルのアドレスになります。 
4. ホスト環境の LAN は、仮想 LAN 1 (VLAN1) および仮想 LAN 2 (VLAN2) の 2 つのセグメントに分割されて表示されています。
a. VLAN1 (非武装地帯 または DMZ と呼ばれることがある) は <CSSWebServer> のような仮想サーバーの接続に使用します。 ネットワーク デバイスは IP トラフィックをこのセグメント (ポート 80 および 443 でのみ許可される着信トラフィック) へ送信するよう構成されているため、外部からの攻撃からセキュリティで保護されているとはみなされません。 したがって、インターネットで必要とされるこれらのマシンのみこの VLAN に接続されています。
b. LAN のもう一方のセグメント VLAN2は直接インターネットには接続されていないため、外部からの攻撃を直接受けません。 ネットワーク デバイスは、この VLAN からインターネットへの内向きトラフィックまたは外向きトラフィックを拒否するよう構成されています。 CCF IIS サーバー、CCF SQL Server など他のすべてのマシンおよび CCF ドメイン コントローラはこの VLAN に接続されています。
5. (ファイアウォールとして動作している) ネットワーク デバイス経由の VLAN1 および VLAN2 の接続は、<CSSWebServer> が CCF IIS サーバーおよび CCF ドメイン コントローラと通信できる程度に制限されています。 2 つの VLAN 間で許可されているトラフィックは次のとおりです。
a. Web サービスにアクセスするためのポート 80 および 443 での <CSSWebServer> と <IISSvr> の間
b. ドメイン コントローラの Active Directory にアクセスし、Windows 統合認証を実行するのに必要なポート 389 および 3268 での <CSSWebServer> と CCF ドメイン コントローラの間
6. <CSSWebServer>、<IISSvr>、および <SQLSvr> は単一ドメインの一部です。 これにより (インターネットに公開されている) <CSSWebServer> は、Windows 統合認証で制限されたアクセス許可を持つ <IISSvr> で CSS Web サービスにアクセスできます。 この構成は本書の後半で説明します。 また、Web Services on <IISSvr> の Web サービスは Windows 統合認証を使用して <SQLSvr> の CCS データベースにアクセスします。
注: これは単に、基本的なインストールの参照展開アーキテクチャです。 展開の担当者は、CCS ポータルの実装における必要性に応じてこのアーキテクチャをアップグレードまたは変更しなければならない場合があります。
必要なソフトウェア
インストールを始める前に、以下の点を確認してください。
Windows 2000 Server のハードウェア要件を満たすまたはそれを超えるサーバー 4 台 (<DomainController>、<IISSvr>、<CSSWebServer>、および <SQLSvr>)。
Windows XP Professional のハードウェア要件を満たすまたはそれを超えるクライアント 1 台。
· 展開環境に必要なメディアを以下に一覧表示します。Windows 2003 SP1 Server
· IIS 6.0
· SQL Server 2000 (SP3 適用済み)
· Content Management Server 2002 SP1 (Site Manager Tool 付属)
· .NET Framework 1.1
· Internet explorer 6.0 以降
· Microsoft EIF
ドメイン コントローラ
CSS も 顧客サービス担当者 (CSR) 環境にインストールする必要がある場合は、CSR のドメイン コントローラは CSS の場合と同様に使用できるため、このセクションをスキップできます。 

CSS を異なる環境にインストールする必要がある場合は、新しいドメイン コントローラをインストールし、CCF ドメイン コントローラとまったく同じに構成する必要があります。 上記の Customer Service Representative Application (Agent Desktop) セクションにあるサブセクション Domain Controller に従います。 サブセクション CCFUsers および CCFAdmins をスキップします。
SQL Server
CSS を CSR 環境にインストールしている場合は、CCF の SQL Server は CSS の場合と同様に使用できるため、このセクションをスキップできます。
CSS を異なる環境にインストールする必要がある場合は、新しい SQL Server をインストールし、CCF の SQL Server とまったく同じに構成する必要があります。 上記の Customer Service Representative Application (Agent Desktop) セクションにあるサブセクション SQL Server に従います。 このサブセクションの最後の手順 (手順 6) をスキップします。
IIS サーバー
CSS ポータル アプリケーションには IIS サーバーが 2 台必要です。 IIS サーバー 1 台で、CSS ポータルおよび CSR デモ アプリケーションに必要な Web サービスをホストします。 このサーバーの名前は <IISSvr> (CCF IIS サーバー) です。 もう 1 台の IIS サーバーは CSS ポータルの Web ページをホストします。 このサーバーの推奨されている名前は <CSSWebServer> です。
CCF IIS のインストール手順
CSS Web サービスはこのサーバーにインストールされます。
CSS が CSR 環境にインストールされている場合は、CSS Web サービスを CSR 環境の IIS サーバー (<IISSvr> など) にインストールする必要があります。
CSS を異なる環境にインストールする必要がある場合は、新しい IIS サーバーをインストールし、CCF の IIS サーバーとまったく同じに構成する必要があります。 上記の Customer Service Representative Application (Agent Desktop) セクションにあるサブセクション IIS Server
 に従います。
CCF Web サーバーのインストール手順
CSS フロントエンド Web アプリケーションがこのサーバーにインストールされます。
マシン: <CSSWebServer> 
ログイン ユーザー: ローカル管理者
1. Windows 2003 SP1 Server をインストールし、CCF ドメインに参加します。 
注: IIS 6.0 がインストールされていることを確認します。 
2. CMS 2002 サーバーおよび Site Manager Tool をインストールします。
CMS 2002 インストールの必要条件
a. Internet Explorer webcontrols。
    
Internet Explorer webcontrols は CMS CD の webcontrols フォルダまたは以下の場所からダウンロードできます。
http://www.microsoft.com/downloads/details.aspx?familyid=fac6350c-8ad6-4bca-8860-8a6ae3f64448&displaylang=en
b. <SQLSvr> に CSSCMS という名前の空のデータベースを作成します。 ローカル管理者アカウントに、作成されたに CSSCMS データベースの DBO 権があることを確認します。
c. 以下の手順に従って Install Serverside に World Wide Web サービスのコンポーネントを含めます。
i. [Add/Remove programs] へ移動し、[Add/Remove Windows Components]、[Application Server] の順にクリックして、[Details] をクリックします。
ii. 表示された画面で、ASP.Net が選択されていることを確認します。 一覧から [IIS] をクリックし、[Details] をクリックします。
iii. 表示された画面で、[World Wide Web Service] をクリックし、[Details] をクリックします。
iv. 表示された画面で、[Active Server Pages]、[Serverside Includes] および [World Wide Web Service] が選択されていることを確認します。
v. 表示される 3 つの画面すべてで [OK] をクリックし、[Next] をクリックします。
d. 再配布可能 J#.net 1.1 [J#.net 1.1 redistributable is available in the pre-requisites folder of Visual Studio.net installation].
e. SQL クライアントがインストールされ、<SQLSvr> サーバーに接続されていることを確認します。
注: CMS のインストールは、SP1 が適用された CMS 2002 セットアップ メディアと適応されていないメディアの 2 種類のメディアで使用できます。 使用できるメディアにより、以下のセクションに従ってインストールを行う必要があります。
CMS 2002 サーバーのインストール (SP1 が適用されていない CMS 2002 セットアップ)
マシン: <CSSWebServer> 
ログイン ユーザー: ローカル管理者
a. CMS Installation の Setup.exe を実行します。
b. [Install Components] をクリックします。
c. [MCMS component] をクリックします。
d. [Miscrosoft Content Management Server Installation] 画面で [Next] をクリックします。
e. 使用許諾契約に同意し、[Next] をクリックします。
f. [Custom Setup] 画面で、CMS Server のみインストール対象として選択されている (SiteManager は選択されていない) ことを確認し、[Next] をクリックします。
g. [Customer Information] 画面で [Next] をクリックします。
h. [Disk Cache Folder] 画面で [Next] をクリックします。
i. [Launch Database Configuration Application after installation is completed] チェック ボックスがオンになっている場合は、オフにします。
j. [Ready to Install the Program] 画面で [Install] をクリックします。
k. [InstallShield Wizard Completed] 画面で [Finish] をクリックします。
CMS 2002 SP1 のインストール:
マシン: <CSSWebServer> 
ログイン ユーザー: ローカル管理者
a. CMS 2002 SP1 を起動します。
b. [MCMS Installation] 画面で [Next] をクリックします。
c. 使用許諾契約に同意し、[Next] をクリックします。
d. [Service Pack 1 Installation] 画面で [Next] をクリックします。
e. “Site Manager” をインストールし、"Developer Tools" をインストールせず、Service Pack 1 のインストールで "Site Stager" をインストールして、[Next] をクリックします。
f. [Ready to Install SP1] 画面で [Install] をクリックします。
g. [Installations of MCMS 2002 Service Pack 1 Complete] 画面で、[Launch DCA] をクリックします。
CMS 2002 サーバーのインストール (SP1 が適用された CMS 2002 セットアップ)
マシン: <CSSWebServer> 
ログイン ユーザー: ローカル管理者
a. CMS Installation の Setup.exe を実行します。
b. [Install Components] をクリックします。
c. [MCMS component] をクリックします。
d. [Miscrosoft Content Management Server Installation] 画面で [Next] をクリックします。
e. 使用許諾契約に同意し、[Next] をクリックします。
f. [Custom Setup] 画面で、[CMS Server] および [Site Manager] のみインストール対象として選択されていることを確認し、[Next] をクリックします。
g. [Customer Information] 画面で [Next] をクリックします。
h. [Disk Cache Folder] 画面で [Next] をクリックします。
i. [Launch Database Configuration Application after installation is completed] を選択します。
j. [Ready to Install the Program] 画面で [Install] をクリックします。
k. [InstallShield Wizard Completed] 画面で [Finish] をクリックします。
Database Configuration Application
a. [Database Configuration Application] 画面で [Next] をクリックします。
b. [Choose The MCMS Content Server ASP Compatibility Mode] 画面で、[Mixed Mode] をクリックし、[Next] をクリックします。
c. [Please Select a virtual site for hosting the Microsoft CMS] 画面で、リストボックスで [default website] をクリックし、[Read/Write site] をクリックして、[Next] をクリックします。
d. [SCA Web Entry Point] 画面で、[default website] をクリックし、[Next] をクリックします。
e. 警告ダイアログ [whether to proceed with a selected site] で、[Yes] をクリックします。
f. [MCMS System Account] 画面で、ユーザーに [CCF Domain administrator] を指定し、そのパスワードを指定します。
g. IIS を停止するかどうか確認するダイアログで [Yes] をクリックします。
h. [Select MCMS Database] 画面で、[Select Database] をクリックします。
i. [SQL Server Login] ダイアログ ボックスで、サーバーに <SQLSvr> を指定し、信頼関係接続または DBO 権のある他の SQL ログインを使用します。
j. [Options] をクリックします。
k. [Database] ボックスの [Options] で、[CSSCMS] をクリックし、[OK] をクリックします。
l. [Next] をクリックします。
m. MCMS スキーマをインストールするかどうか確認するプロンプトで、[Yes] をクリックします。
n. [Database population] 画面で、[Next] をクリックします。
o. [Select Initial MCMS administrator] 画面で、CCF ドメイン管理資格情報を指定し、[Next] をクリックします。
p. [MCMS sites Stager access configuration] 画面で、[No - Do not restrict access] をクリックし、[Next] をクリックします。
q. [Please notify the database administrator..] 画面で [OK] をクリックします。
r. 終了画面で SCA を起動しないように選択します。
s. [Finish] をクリックします。
3. 以下の手順に従って ASPUSER を IIS_WPG グループに追加します。
a. システムのデスクトップで [My Computer] アイコンを右クリックします。
b. [Manage] をクリックします。
c. [System Tools] 下で [Local Users and Groups] をクリックし、[Users and Groups] フォルダを表示します。
d. [Groups] をダブルクリックし、[IIS_WPG] を開きます。
e.  [Add] をクリックして、<DomainName>\ASPUSERを IIS Worker Process Group に追加し、[OK] をクリックします。
4. <DomainName>\ASPUSER には以下の ACL が <CSSWebServer> で必要です。以下の変更を行うには、エクスプローラを開き以下の手順で示す既定の場所に移動します。
· フォルダのアクセス許可:
· 既定の場所: <OSDRIVE>\Windows\TEMP
· アクセスの種類: Full Control
· ASP .NET Dynamic Compilation フォルダ:
· 既定の場所: <OSDRIVE>\WINDOWS\Microsoft.NET\Framework\v1.1.4322\Temporary ASP.NET Files
· アクセスの種類: Full Control
· ASP .NET インストール フォルダ
· 既定の場所: <OSDRIVE>\Windows\Microsoft.NET\Framework\v1.1.4322 
· アクセスの種類: Read & Execute、List Folders Contents、Read
<CSSWebServer> で実行している Web ページ間をセキュリティで保護された接続にするには、<CSSWebServer> で以下の設定を行う必要があります。 既定のアプリケーション プールの ID を <DomainName>\ASPUSER へ変更します。 IIS サーバーの既定のアプリケーション プールの ID を変更するには、以下の手順に従います。
· [Start] -> [Program] -> [Administrative Tools] -> [Internet Information Services (IIS) Manager] の順にクリックします。
· [CSSWebServer] ノードを展開します。
· [<CSSWebServer>] ノードの [Application Pools] を展開します。
· [Application Pools] で [DefaultAppPool] をクリックします。
· [DefaultAppPool] を右クリックし、[Properties] をクリックします。
· [Identity] タブをクリックします。
· [Configurable] をクリックします。
· ユーザー名に <DomainName>\ASPUSER を入力し、<DomainName>\ASPUSER のパスワードを入力します。
· [Apply] をクリックし、[OK] をクリックします。
これで IIS Worker プロセスの ID が変更されました。 

クライアントのインストール手順
1. Windows XP のインストール
2. Windows XP SP2 以降のインストール
データベースのインストール
マシン: <SQLSvr>
ログイン ユーザー: ローカル管理者
1. <SQLSvr> マシンで、コマンド プロンプトを開き、<UnzipDir>\Database\CSS フォルダを見つけます。コマンド プロンプトで以下のバッチ ファイルを実行します。
BuildCSSDb.cmd CCF\ASPUSER.
注: CCF は CCF ネットワークのドメイン名を表しています。 ドメイン名が異なる場合は、同等のドメイン名と置き換えます。
これにより CCFCSS データベース、関連テーブル、およびストアド プロシージャが作成されます。 

2. これで、<DomainName>\ASPUSER は上記で作成されたストアド プロシージャを実行する認証ユーザーです。 

Web ページおよび Web サービスのインストール
CCF-CSS Web ページのインストール
マシン: <CSSWebServer> 
ログイン ユーザー: ローカル管理者
1. <CSSWebServer> で、<UnzipDir>\Setup\CSS\Application フォルダの setup.exe を使用して CCF-CSS Web ページをインストールします。 インストール中は、マシンのログイン ユーザーがローカル管理者またはドメイン管理者であることを確認します。
2. 画面で既定の設定を承認します。
3. これにより CCF-CSS ポータル Web ページが既定のポート 80 にインストールされます。
4. CCFCSSDemo 仮想ディレクトリへの匿名アクセスを許可します。
a. [Start] -> [Program] -> [Administrative Tools] -> [Internet Information Services (IIS) Manager] の順にクリックします。
b. [CSSWebServer] -> [Web Sites] -> [Default Web Site] -> [CCFCSSDemo] の順に移動します。
c. [CCFCSSDemo] を右クリックし、[Properties] をクリックします。
d. [Authentication and Access Control] セクションで [Directory Security] タブをクリックし、[Edit] をクリックします。
e. [Enable Anonymous Access] が選択されていない場合は、選択し、[OK] をクリックします。
f. CCF IIS マシン (<IISSvr> など) が “CCFIIS” でない場合は、Web.config ファイルの文字列 “ccfiss” を実際の <IISSvr> 名と置き換えます。
5. フォルダ <wwwrootDir>\CCFCSSDemo を参照します。 そのフォルダの下に Activation という名前のフォルダを作成します。 
<DomainName>\ASPUSER および IIS_WPG アカウントに対して、上記で作成したフォルダに書き込みアクセス権を与えます。
CSS-CSRDemo Web サービスのインストール
マシン: <IISSvr>
ログイン ユーザー: ローカル管理者
これらは CSR デモ アプリケーションだけでなく、CSS ポータル Web ページで使用される Web サービスです。
1. <IISSvr> で、<UnzipDir>\Setup\CSS\WebServices\CSRCSSWebService フォルダの setup.exe を使用して CSS-CSRDemo Web サービスをインストールします。
2. これにより、CSS および CSRDemo 両方に共通の Web サービスが既定のポート 80 にインストールされます。
3. CSRCSSWebService 仮想ディレクトリへの匿名アクセスを無効にします。 

a. [Start] -> [Program] -> [Administrative Tools] -> [Internet Information Services (IIS) Manager] の順にクリックします。
b. [<IISSvr>] -> [Web Sites] -> [Default Web Site] -> [CSRCSSWebService] の順に移動します。
c. [CSRCSSWebService] を右クリックし、[Properties] をクリックします。
d. [Authentication and Access Control] セクションで [Directory Security] タブをクリックし、[Edit] をクリックします。
e. [Enable Anonymous access] チェック ボックスがオンになっている場合は、オフにし、[OK] をクリックします。
4. CSS-CSRDemo Web サービス <wwwrootDir>\ CSRCSSWebService) の Web.CONFIG ファイルの appSettings セクションには以下の重要な構成情報が入っています。 

· ConnectionString – この設定の既定値は "Server=CCFSQL;Integrated Security=true;Database=CCFCSS " です。 データベースが CCFSQL ではないマシンにインストールされている場合は、SQL Server 名を変更します。
5. CSS-CSRDemo Web サービス (<wwwrootDir>\CSRCSSWebService) の EnterpriseInstrumentation.config ファイルの eventSinks セクションには以下の重要な構成情報が入っています。
· DBConnectionString – この設定の既定値は "Server=CCFSQL;Integrated Security=true;Database=CCFCSS;Pooling=false" です。 データベースが CCFSQL ではないマシンにインストールされている場合は、SQL Server 名を変更します。
6. CSS-CSRDemo Web サービスのアプリケーション プールを DefaultAppPool から CCFAppPool へ変更するには、以下の手順に従います。
a. [Start] -> [Program] -> [Administrative Tools] -> [Internet Information Services (IIS) Manager] の順にクリックします。
b. [<IISSvr>] -> [Web Sites] -> [Default Web Site] の順に移動します。
c. [Default Web Site] で [CSRCSSWebService] をクリックします。
d. 表示されたメニューで右クリックし、[Properties] をクリックします。
e. [Application pool] ボックスで、[CCFAppPool] をクリックします。
f. [OK] をクリックします。
CSS Web サービスのインストール
マシン: <IISSvr>
ログイン ユーザー: ローカル管理者
これらは、CSS ポータル Web ページでのみ使用される Web サービスです。
1. <IISSvr> で、<UnzipDir>\Setup\CSS\WebServices\CSSWebServices フォルダの setup.exe を使用して CSS Web サービスをインストールします。
2. これにより、CSS に固有の Web サービスが既定のポート 80 にインストールされます。
3. CSSWebServices 仮想ディレクトリへの匿名アクセスを無効にします。 

a. [Start] -> [Program] -> [Administrative Tools] -> [Internet Information Services (IIS) Manager] の順にクリックします。
b. [<IISSvr>] -> [Web Sites] -> [Default Web Site] -> [CSSWebServices] の順に移動します。
c. [CSSWebServices] を右クリックし、[Properties] をクリックします。
d. [Directory Security] タブをクリックし、[Edit] をクリックします。
e. [Enable Anonymous access] チェック ボックスがオンになっている場合は、オフにし、[OK] をクリックします。
4. CSS Web サービス <wwwrootDir>\CSSWebservices) の Web.Config ファイルの appSettings セクションには以下の重要な構成情報が入っています。 

· ConnectionString – この設定の既定値は "Server=CCFSQL;Integrated Security=true;Database=CCFCSS;Pooling=false" です。 データベースが CCFSQL ではないマシンにインストールされている場合は、SQL Server 名を変更します。
5. CSS Web サービス (<wwwrootDir>\CSSWebServices) の EnterpriseInstrumentation.config ファイルの eventSinks セクションには以下の重要な構成情報が入っています。
· DBConnectionString – この設定の既定値は "Server=CCFSQL;Integrated Security=true;Database=CCFCSS" です。 データベースが CCFSQL ではないマシンにインストールされている場合は、SQL Server 名を変更します。
6. CSS Web サービスのアプリケーション プールを DefaultAppPool から CCFAppPool へ変更するには、以下の手順に従います。
a. [Start] -> [Program] -> [Administrative Tools] -> [Internet Information Services (IIS) Manager] の順にクリックします。
b. [<IISSvr>] -> [Web Sites] -> [Default Web Site] の順に移動します。
c. [Default Web Site] で [CSSWebServices] をクリックします。
d. 表示されたメニューで右クリックし、[Properties] をクリックします。
e. [Application pool] ボックスで、[CCFAppPool] をクリックします。
f. [OK] をクリックします。
CMS の構成
<CSSWebServer> で CMS を構成するには、以下の手順に従います。
CMS パッケージのインポート
マシン: <CSSWebServer> 
ログイン ユーザー: ローカル管理者
1. <OSDRIVE> 直下に CCFCSSDemo という名前のフォルダを作成します。
2. <UnzipDir>\Others\Settings フォルダの CMSCSS.sdo ファイルを <OSDRIVE>\CCFCSSDemo フォルダへコピーします。
3. <CSSWebServer> で、[Start] -> [Programs] -> [Microsoft Content Management Server] -> [SiteManager] の順にクリックして、CMS の “Site Manager tool” を開きます。
4. [Connect to server] および [connect to port] オプションで正しい接続設定を指定し、[OK] をクリックします。
5. 正しいユーザーの資格情報を指定し、[Start] をクリックします。
6. CCFCSSDemo が channels 一覧に表示されているか確認します。 表示されている場合は、CCFCSSDemo チャンネルを削除します。 Deleted Items フォルダからもこのチャンネルを削除します。
7. [File] -> [Package] -> [Import] オプションの順にクリックします。
8. <OSDRIVE>\CCFCSSDemo フォルダから CMSCSS.sdo ファイルを参照し、[Import] をクリックします。
9. 確認画面で、[Continue] をクリックします。
10. これにより、チャンネルとテンプレート ファイルが Content Management Server にインポートされます。 連絡先、FAQ (よく寄せられる質問)、および既定のページとともに CCFCSSDemo チャンネルが作成されているかどうかチェックすることで検証できます。
サーバー構成アプリケーションでの匿名ユーザー アクセスの許可
マシン: <CSSWebServer> 
ログイン ユーザー: ローカル管理者
1. [Start] -> [Programs] -> [Content Management Server] -> [Server Configuration Application] の順にクリックし、[Server Configuration Application] を開きます。
2. [Access] タブをクリックします。 
3. [Configure] をクリックします。
4. 表示されたウィンドウで、一覧に <CSSWebServer> を追加し、[OK] をクリックします。
5. SCA メイン ウィンドウで [Security] タブをクリックします。
6. [Configure] をクリックします。
7. [Allow Guests On Site] を [Yes] に変更します。
8. [Guest Login Account] の横の [Browse] をクリックします。
9. 表示されたウィンドウで、[OK] をクリックすると続行します。
10. ドロップダウン リストで <CSSWebServer> をクリックし、IUSR_<CSSWebServer> アカウントをクリックします。
11. [OK] をクリックします。
12. [OK] をクリックして構成ウィンドウを閉じます。
13. サーバー構成アプリケーションを閉じます。
CMS でのユーザー ロールの設定
マシン: <CSSWebServer> 
ログイン ユーザー: ローカル管理者
1. [Start] -> [Programs] -> [Microsoft Content Management Server] -> [Site Manager] の順にクリックし、アプリケーションにログインします。
2. 左側のペインで、[User Roles] をクリックします。
3. [User Roles] ボックスで、[Subscribers] を右クリックし、[New Rights Group] をクリックします。
4. [Subscribers] ボックスで、新しく作成された [New Rights Group] を右クリックし、CMSCSS へ名前を変更します。
5. [CMSCSS] を右クリックし、[Properties] をクリックします。
6. [Properties] ウィンドウで、[Group Members] タブをクリックします。
7. [Modify] をクリックします。
8. 表示されたウィンドウで、[NT Domains] から <CSSWebServer> (<CSSWebServer> が一覧表示されていない場合は、[Synchronize] をクリック) をクリックします。
9. ドロップダウン リストで、[Select from list of all groups and users] をクリックします。
10. 表示されたリスト ビューで、[IUSR_<CSSWebServer>] をクリックし、[Add] をクリックします。
11. [OK] をクリックしてウィンドウを閉じます。
12. [Properties] ウィンドウの [Group Rights] タブをクリックします。
13. 一覧で X という印が付いた各項目を 1 回クリックし、チェックマークに変更します。
14. [OK] をクリックし、[Properties] ウィンドウを閉じます。
15. 左側のペインの [Site Manager] で、[Channels] をクリックします。
16. [Channels] ツリーで、[CCFCSSDemo] を右クリックし、[Properties] をクリックします。
17. [Properties] ウィンドウで、[Rights] タブをクリックします。
18. [Modify] をクリックします。
19. [Look] ボックスで、[Subscribers] をクリックします。
20. [CMSCSS] をクリックし、[Add] をクリックします。
21. [OK] をクリックしてウィンドウを閉じます。
22. [OK] をクリックし、[Properties] ウィンドウを閉じます。
23. Site Manager を終了します。
CMS 仮想フォルダの作成手順
マシン: <CSSWebServer> 
ログイン ユーザー: ローカル管理者
1. IIS Manage アプリケーションを開きます。 

2. [Default Web Site] を右クリックし、[CCFCSSDemo] をクリックして [New] -> [Virtual Directory] の順にクリックします。
3. ようこそ画面で [Next] をクリックします。
4. [Alias] ボックスに CMS を入力します。
5. [Next] をクリックします。
6. [Web Site Content Directory] 画面で [Browse…] をクリックし、パス <OSDRIVE>\Program files\Microsoft Content Management Server\Server\IIS_CMS を選択します。 
7. [Next] をクリックします。
8. [Access Permissions] 画面で [Next] をクリックします。
9. [Finish] をクリックし、ウィザードを終了します。
10. IIS 管理コンソールで新しく作成された仮想ディレクトリ CMS を右クリックし、[Properties] をクリックします。
11. [Application name] ボックス横の [Remove] をクリックすることで、この仮想ディレクトリのアプリケーション名を削除します。
12. [OK] をクリックします。
検証
マシン: 任意のマシン (CSSWebServer がインターネットに公開されている場合) またはローカル ドメインのマシン (CSSWebServer がインターネットに公開されていず、ローカル ドメインのマシンがインターネットにアクセスできる場合)
ログイン ユーザー: ローカル管理者
インストールが完了したら、クライアント マシンのエクスプローラでhttp://CSSWebServer/CCFCSSDemo/CSSDefault.aspx を指定し、CSS ポータルを参照します。(“CSSWebServer” は <CSSWebServer> を表します  サーバー名が “CSSWebServer” でない場合は、適切なサーバー名と置き換えます)。
CSS ポータルの最初のページが開きます。
ログイン名とパスワードに JohnSmith と入力してポータルにログインします。 

メンバのエリア ページが開きます。
ポータルで既定で構成されている他の顧客の資格情報 (それぞれユーザー名およびパスワード) は次のとおりです。
MathewRoberts、MathewRob
Elizabeth、Elizabeth
CSS のアンインストール
CCF-CSS Web ページのアンインストール
CSS ポータル Web ページをアンインストールするには、以下の手順に従います。マシン: <CSSWebServer> 
ログイン ユーザー: ローカル管理者
1. <CSSWebServer> で、[Start] -> [Programs] -> [Control Panel] -> [Add or Remove Programs] の順にクリックします。
2. [CCF CSS Portal Application] をクリックし、[Remove] をクリックします。
3. 以下の手順に従って、仮想ディレクトリを削除します。
a. [Start] -> [Program] -> [Administrative Tools] -> [Internet Information Services (IIS) Manager] の順にクリックします。
b. [<CSSWebServer>] -> [Web Sites] -> [Default Web Site] -> [CCFCSSDemo] の順に移動します。
c. [CCFCSSDemo] を右クリックし、[Delete] をクリックします。
CSS-CSRDemo Web サービスのアンインストール
CSS-CSRDemo Web サービスをアンインストールするには、以下の手順に従います。
マシン: <IISSvr>
ログイン ユーザー: ローカル管理者
1. <IISSvr> で、[Start] -> [Programs] -> [Control Panel] -> [Add or Remove Programs] の順にクリックします。
2. [CCF CSS-CSRDemo Web Services] をクリックして、[Remove] をクリックします。
3. 以下の手順に従って、仮想ディレクトリを削除します。
a. [Start] -> [Program] -> [Administrative Tools] -> [Internet Information Services (IIS) Manager] の順にクリックします。
b. [<IISSvr>] -> [Web Sites] -> [Default Web Site] -> [CSRCSSWebService] の順に移動します。
c. [CSRCSSWebService] を右クリックし、[Delete] をクリックします。
注: これらの Web サービスは、CSS ポータル アプリケーションおよび CSR デモ アプリケーションに共通です。 アンインストール後は、CSR デモ アプリケーションは動作しない場合があります。
CSS Web サービスのアンインストール
CSS Web サービスをアンインストールするには、以下の手順に従います。
マシン: <IISSvr>
ログイン ユーザー: ローカル管理者
1. <IISSvr> で、[Start] -> [Programs] -> [Control Panel] -> [Add or Remove Programs] の順にクリックします。 

2. [CCF CSS Web Services] をクリックして、[Remove] をクリックします。
3. 以下の手順に従って、仮想ディレクトリを削除します。
a. [Start] -> [Program] -> [Administrative Tools] -> [Internet Information Services (IIS) Manager] の順にクリックします。
b. [<IISSvr>] -> [Web Sites] -> [Default Web Site] -> [CSSWebServices] の順に移動します。
c. [CSSWebServices] を右クリックし、[Delete] をクリックします。
トラブルシューティング

	問題
	原因
	ソリューション

	CSS ポータル ページの右上部に白色の空ボックスが表示されます。
	これは動画 GIF の広告イメージです。 動画が再生されていないので、白色の空ボックスで表示されています。
	エクスプローラを開き、[Tools] -> [Internet Options] の順にクリックします。 [Advanced] タブをクリックします。 [Play animations in web pages] というチェックボックスをオンにします。 ダイアログ ボックスで [OK] をクリックします。

	単一マシン環境 (サーバーおよびクライアントがすべて 1 台の Win2k3 SP1 マシンにインストールされている) で、CSS ページに移動するときに“401: Unauthorized” というエラーが表示されます。
	Windows 2003 SP1 にはループバック チェック セキュリティ機能関連のバグがあります。 詳細については、http://support.microsoft.com/default.aspx?scid=kb;en-us;896861 を参照してください。
	ループバック チェック セキュリティ機能をオフにします。 以下の手順に従います。
a. [Start]、[Run] の順にクリックし、regedit を入力して [OK] をクリックします。 

b. レジストリ エディタで、以下のレジストリ キーを見つけ、クリックします。
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Lsa 
c. [Lsa] を右クリックし、[New] をポイントして、[DWORD Value] をクリックします。 

d. DisableLoopbackCheck と入力し、ENTER キーを押します。 

e. [DisableLoopbackCheck] を右クリックし、[Modify] をクリックします。 

f. [Value] ボックスで、1 と入力し [OK] をクリックします。 

g. レジストリ エディタを終了して、コンピュータを再起動します。
重要: これは単一マシン環境に固有であり、複数マシン環境ではほとんど発生しません。 この修正は、実稼動環境にはお勧めしません。
複数マシン環境で試してみる場合は、ローカル管理者でログインし、<IISSvr> マシンおよび <CSSWebServer> マシンで上記の手順を行います。


セキュリティの考慮事項
このセクションは、CSS に関連したセキュリティの考慮事項および CCF 2.0 の CSS モジュールを使用する際に発生する可能性のあるセキュリティ問題の回避方法について説明します。
1. CSS ポータルでは、ユーザー名、パスワード、クレジット カード情報、SSN 番号、銀行の口座番号などユーザーの個人データは、Web サービス、アプリケーション、およびユーザーのブラウザ間を HTTP 経由で渡されます。 すべての通信チャンネルで、このユーザーの個人データをセキュリティで保護することは非常に重要です。 したがって、HTTP 通信には SSL (HTTPS) レイヤを使用するようにしてください。
2. すべてのマシンを最新の修正プログラムで更新しておいてください。
3. すべての Web サービスの HTTP Get および Post アクセスを無効にしてください。 SOAP アクセスのみ有効にします。 これは Web サービスの web.config で設定できます。
Information Bridge Framework ブローカー
このセクションは、IBF ブローカー コンポーネントのセットアップに必要な手順について説明します。 IBF ブローカーは、LOB アプリケーション データとサービスを IBF 互換Web サービスに提供するためのフレームワークです。 IBF ブローカーは、クラス ライブラリとして設計されており、LOB アプリケーションの詳細情報とそのアプリケーションで可能な操作が構成されているメタ データ構成ファイルを使用します。 リアルタイムな展開では、IBF 互換 Web サービスは IBF ブローカーを参照して LOB アプリケーションにアクセスします。
IBF ブローカーのインストール:
1. IBFBroker.DLL を IBF Compatible web service フォルダにコピーします。
2. IBFBrokerMetadataStore.xml を IBF Compatible web service フォルダにコピーします。
3. Web サービス構成ファイルの以下のキーを追加します。
4. <appSettings>
5. <add key="IBFBroker.MetadataStore" value="IBFBrokerMetadataStore.xml"/>
6. </appSettings>


キーの値は Web サービス ルート フォルダに対するパス IBFBrokerMetadataStore.xml をポイントしている必要があります。
データの抽象化およびキャッシュ レイヤ (DACL)
このセクションは、データ抽象化およびキャッシュ レイヤ V2.0 (以前は SKTI V2.0) をパイロット環境にセットアップするのに必要な手順について説明します。
このプロジェクトの主な目的は、あらゆる種類の BizTalk ビジネス プロセス開発者が Web サービスとして公開されている各種業務アプリケーションを統合することでソリューション開発に活用できる、BizTalk との Web サービス バインディング フレームワーク (WSBF) を作成することです。
またこのプロジェクトは、CCF と BizTalk 2004 との統合を示すために、CCF でホストされた 3 つのサンプル アプリケーションの作成およびホスティングを目的としています。
このドキュメントは、サーバーおよびクライアント マシンにデータ抽象化およびキャッシュ レイヤ V2.0 をインストールする方法を説明しています。 このプロジェクトは SKTI 1.5 のアップグレードです。 またこのドキュメントは、SKTI 1.5 の一部だった DACL キャッシュのインストール手順について説明しています。
このドキュメントは、2 つのセクションに分割されています。
· Web サービス バインディング フレームワーク (WSBF) のインストール
· WSBF フロントエンド サーバーのインストール
· WSBF バックエンド サーバーのインストール
· Microsoft DACL キャッシュのインストール
· DACL キャッシュ フロントエンド サーバーのインストール
· DACL キャッシュ バックエンド サーバーのインストール
必要なソフトウェア
インストールを始める前に、以下の点を確認してください。
· ハードウェア調達費
· Windows 2003 Server のハードウェア要件を満たすまたはそれを超えるサーバー 2 台。
· ソフトウェア費
· オペレーティング システムおよび Service Pack
· Windows 2003 Server または Windows 2003 Server SP1 または Windows 2000 Server SP3 または Windows XP Professional SP 1
· SQL サーバー 2000 Standard
· SQL Server 2000 SP 3
· フレームワークおよびランタイム ライブラリ
· .NET Framework V 1.1 (Service Pack なし)
· Office XP SP1 または Office 2003
· Office XP Primary Interop Assemblies
· - Contact Center Framework セットアップ
· Microsoft WSE 1.0 – SP1
· Enterprise Instrumentation Framework セットアップ
· その他のソフトウェア
· BizTalk Server 2004 – Enterprise Edition.
(BizTalk Server 2004 のインストールの要件については「参考ドキュメント」セクションの「BizTalk システムの要件」を参照してください。)
· データの抽象化およびキャッシュ レイヤ V2.0 (DACL 2.0) セットアップ
WSBF フロントエンド サーバーのインストール
インストール手順
1. Windows 2003 Server または Windows 2003 Server SP1 または Windows 2000 Server SP3 または Windows XP Professional SP 1 をインストールします。
· オペレーティング システムが Windows 2003 の場合は、アプリケーション サーバーとして構成します。
· オペレーティング システムが Windows 2000 の場合は、IIS がインストールされていることを確認します。
2. オペレーティング システムが Windows XP Professional の場合は、IIS 6.0 がインストールされていることを確認します。
3. オペレーティング システムが Windows 2003 SP1 の場合は、以下の手順に従って MSDTC を構成します。
a. [Start] -> [Settings] -> [Control Panel] -> [Administrative Tools] -> [Component Services] の順にクリックします。 
b. [Component Services]、[Computers] の順に展開します。 
c. [My Computer] を右クリックし、コンテキスト メニューで [Properties] をクリックします。 
d. [Properties] ウィンドウで、[MSDTC] タブをクリックします。 
e. [Transaction Configuration] エリアで、[Security Configuration] をクリックします。 
f. [Security Settings] エリアで、[Network DTC Access] チェック ボックスをオンにします。 
g. [Client And Administration] エリアで、[Allow Remote Clients] チェック ボックスをオンにします。
h. [Transaction Manager Communication] エリアで、[Allow Inbound] チェック ボックス、[Allow Outbound] チェック ボックスの順にオンにし、[No Authorization Required] をクリックします。
i. それぞれ開いたダイアログ ボックスで [OK] をクリックします。
4. Windows Message Queuing Services をインストールします。
5. BizTalk Server 2004 をインストールします。
6. Enterprise Instrumentation Framework をインストールします。
7. Microsoft WSE 1.0 – SP1 をインストールします。
8. SSO Administrators グループの一部となるようにユーザー (現在のログイン ユーザー) を構成します。
a. [Start] メニューで、[Control Panel] -> [Administrative Tools] -> [Computer Management] の順にクリックします。 

b. [Users] に移動します。
[System Tools] -> [Local Users and Groups] -> [Groups] -> [Users] の順にクリックします。
c. [SSO Administrators] を右クリックし、[Properties] をクリックします。
d. [Add] をクリックします。  

e. 表示される[Select Users, Computers or Groups] ダイアログ ボックスで、現在のユーザーを追加します。 

f. 変更を保存します。  

9. (Setup ->Binding Wizard and Caching フォルダ内の) DACL 2.0 Setup.exe を実行します。 

a. ようこそ画面で [Next] をクリックします。
b. [Choose Destination Folder] 画面で、インストール ディレクトリを選択し、[Next] をクリックします。
c. 表示される [Select Features] 画面で、[Web-Service Binding Framework for Biztalk Server - Frontend Server] チェック ボックスをオンにします。
i. バインディング ウィザード フロントエンド インストールのみ必要な場合は、他の機能のチェック ボックスをすべてオフにします。
d. [Next] をクリックします ([Next] をクリックするときに、セットアップはすべてのフロントエンド アセンブリおよびアダプタを作成および登録します)。
e. [Enter Correlation Web Service Path] 画面で、[Next] をクリックします。
i. 注: ユーザーは、テキスト ボックス フィールドで相関 Web サービスの仮想ディレクトリを変更できます。 この値はインストール パスの bin/config フォルダの config.xml ファイルに格納され、バインディング ウィザードで使用されます。
f. [完了] をクリックしてセットアップを終了します。
10. セットアップが完了したら、Biztalk サービスを再起動します。
a. [Start] メニューで、[Control Panel] -> [Administrative Tools] -> [Services] の順にクリックします。
b. [Biztalk Service Biztalk Group: BizTalkServerApplication] をクリックします。
c. 右クリックし、[Restart] をクリックします。
11. チュートリアル ドキュメントに一通り目を通します。
a. [Start] メニューで、[Programs] -> [Microsoft SKTI 2.0] -> [Web Service Binding Framework for BizTalk Server] -> [Binding Wizard – Tutorial] の順に開きます。
b. 開いたドキュメントの手順を実行します。
注:
1. バインディングが使用中に編集されていないことを確認します。 

使用中のバインディングを編集するには、次の操作を行います。
· 関連するオーケストレーションを停止またはその参加を解除します。
· バインディング ウィザードで作成されたポートの参照先をオーケストレーションの [Port Binding Properties] から削除します。
· BizTalk Service BizTalk Group : BizTalkServerApplication を再起動してから、編集します。
検証手順
マシン: WSBF フロントエンド サーバー
ログイン ユーザー: ドメイン管理者
1. Microsoft SKTI2.0 プログラム フォルダが作成されていることを確認します。 同様のことを検証するために、セットアップを実行中に指定したインストール ディレクトリをチェックします。
2. Microsoft SKTI2.0 プログラム アイコンをチェックし、以下のプログラム アイコンが作成されており、アクセス可能かどうか確認します。
· Web Service Binding Wizard for BizTalk Server 下の Binding Wizard
([Start] -> [Programs] -> [Web Service Binding Wizard for BizTalk Server] -> [Binding Wizard] の順にクリック)。
· Web Service Binding Wizard for BizTalk Server 下の Binding Wizard – Tutorial という名前のバインディング ウィザードのチュートリアル
([Start] -> [Programs] -> [Web Service Binding Wizard for BizTalk Server] -> [Binding Wizard - Tutorials] の順にクリック)。
Microsoft.Web.Services.DLL が .NET Framework の物理フォルダに存在するかどうか確認します。 v1.1.4322 をレジストリの以下のキーに追加するとこの .NET Framework パスが得られます。
HKEY_LOCAL_MACHINE\Software\Microsoft\.NETFramework\InstallRoot
Microsoft.Web.Services.DLL が存在しない場合は、Microsoft WSE 1.0 – SP1 がインストールされているフォルダに移動します。 Microsoft.Web.Services.DLL を .NET Framework の v1.1.4322 フォルダにコピーします。
3. 以下の BizTalk アイテムが作成されているかどうか確認します。
· BizTalk Server Administration ([Start] -> [Programs] -> [Microsoft BizTalk Server 2004] -> [BizTalk Server Administration] の順にクリック)
· アダプタ - 表示された BizTalk 管理コンソールで、Microsoft BizTalk Server 2004 (ローカル) に移動し、[Adapters] をクリックします。
以下のアダプタが作成されているかどうか確認します。
i. MSMQC
ii. WebServiceSendAdapter
WSBF パートナー システムのインストール
インストール手順
1. Windows 2003 Server または Windows 2003 Server SP1 または Windows 2000 Server SP3 または Windows XP Professional SP 1 をインストールします。  

· オペレーティング システムが Windows 2003 Server または Windows 2003 Server SP1 の場合は、アプリケーション サーバーとして構成します。
· オペレーティング システムが Windows 2000 Server SP3 の場合は、IIS 5.0 がインストールされていることを確認します。
· オペレーティング システムが Windows XP Professional SP1 の場合は、IIS 6.0 がインストールされていることを確認します。
2. Microsoft WSE 1.0 – SP1 をインストールします。
3. (Setup ->Binding Wizard and Caching フォルダ内の) DACL 2.0 Setup.exe を実行します。 

a. ようこそ画面で [Next] をクリックします。
b. [Choose Destination Folder] 画面で、インストール ディレクトリを選択し、[Next] をクリックします。
c. 表示される [Select Features] 画面で、[Web-Service Binding Framework for Biztalk Server - BackEnd Server] チェック ボックスをオンにします。
d. バインディング ウィザード バックエンド インストールのみ必要な場合は、他の機能のチェック ボックスをすべてオフにします。
e. [Next] をクリックします ([Next] をクリックするときに、セットアップはカスタム フィルタを作成および登録します)。
f. [Finish] 画面で [Finish] をクリックし、セットアップを完了します。
検証手順
マシン: WSBF パートナー システム
ログイン ユーザー: ドメイン管理者
1. インストール フォルダが作成されていることを確認します。
2. 以下のアセンブリのグローバル アセンブリ キャッシュ (%windir%\Assembly) を確認します。
· Microsoft.NSP.WebServiceBindingFramework.CustomFilter
· Microsoft.NSP.SKTI.EIFLogging
· customfilter.resources.dll
単一マシン環境の注意事項 (Windows 2003 Server)
バインディング ウィザードのフロントエンドおよびバックエンド サーバーを、Windows 2003 Server または Windows 2003 Server SP1 がインストールされたコンピュータにインストールできます。
インストール
1. Setup.EXE. を実行します。
2. フロントエンドおよびバックエンド両方のインストール オプションを選択します。
· Web Service Binding Framework for BizTalk Server - フロントエンド サーバー
· Web Service Binding Framework for BizTalk Server - パートナー サーバー
3. セットアップを完了します。
注: 前のセクション (Installing WSBF Front-end Server  セクションおよび Installing WSBF Front-end Server  セクション) で説明したように、フロントエンドおよびバックエンド サーバーのインストールを確認するために検証します。
DACL キャッシュのインストール
2 台の異なるマシンにインストールを行う必要があります。
1. フロントエンド サーバー
2. バックエンド サーバー
必要なソフトウェア
フロントエンド サーバー
· Windows 2k オペレーティング システム (または同等のオペレーティング システム)
· Microsoft .Net Framework (v1.0.3705 以降)
· WSE 1.0 sp1
· Windows Installer 2.0
バックエンド サーバー
· Windows 2k オペレーティング システム (または同等のオペレーティング システム)
· Microsoft SQL Server・2000
· Microsoft .NET Framework
· Windows Installer 2.0
インストール手順
インストールを始める前に、以下の点を確認してください。
1. フロントエンド システムの machine.config ファイルを開き、以下の変更を行います (Machine.config ファイルはディレクトリ <Windows installation path>\Microsoft.NET\Framework\v1.0.3705\CONFIG\machine.config に格納されています)。
processModel 属性を検索します。
userName="[user]" を見つけ、"[user]" を SYSTEM 
(userName="SYSTEM") に変更します。
2. [command prompt] から、または [Start] -> [Run] の順にクリックし iisreset を実行します。
3. SQL Server エージェントがバックエンド サーバーをインストールするマシンで動作しているかどうか確認します。 インストールされていない場合は、SQLSERVERAGENT サービスを起動します。
フロントエンドおよびバックエンド サーバーのインストール
インストール
1. (Setup ->Binding Wizard and Caching フォルダ内の) DACL 2.0 Setup.exe を実行します。 
2. Microsoft DACL キャッシュ フロントエンド サーバーをインストールする場合は、表示された機能一覧で [Microsoft SKTI Caching – Front-end Server] をクリックします。
3. Microsoft DACL キャッシュ バックエンド サーバーをインストールする場合は、表示された機能一覧で [Microsoft SKTI Caching – Back-end Server] をクリックします。


重要:
· フロントエンド サーバーの前にバックエンド サーバーをインストールする必要があります。
· DACL キャッシュ バックエンド サーバーのインストールでは、.NET がインストールされたパスを要求する画面で、.Net Framework の最新バージョンの正しいフォルダ パスが指定されていることを確認します。 指定されたパスが正しくないと、保守サービスがインストールされません。
インストールの検証
正しくインストールされたかどうか、以下の点を確認する必要があります。
フロントエンド サーバー
マシン: フロントエンド サーバー
ログイン ユーザー: ドメイン管理者
1. 以下のレジストリ エントリを HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\SKTICaching に作成します。
· INSTALL_PATH_FRONTEND
· DBConnectionString
· CONNECTION_TIMEOUT
2. 以下のアセンブリをグローバル アセンブリ キャッシュ (%windir%\assembly フォルダ) に登録します。
· Microsoft.NSP.Caching.InvalidationAPI
· Microsoft.NSP.Caching.Utilities
· Microsoft.NSP.Caching
· ErrorLog
3. IIS の仮想ディレクトリ SKTICachingInvalidationService を確認します。
4. バックエンド SQL Server テーブル tbl_CacheWebServerMapping のエントリがデータベース SKTI_Caching に作成されていることを確認します。 列 nvcWebServerName には InvalidationWebservice の URL がなければなりません  (URL は手順 3 で確認した仮想ディレクトリから検証できます)。
バックエンド サーバー
マシン: バックエンド サーバー
ログイン ユーザー: ドメイン管理者
1. データベース SKTI_Caching を SQL マシンに作成する必要があります。 

2. 以下のアセンブリをグローバル アセンブリ キャッシュ (%windir%\assembly) フォルダ に登録します。
· InvalidationComponent
· Microsoft.NSP.Caching.InvalidationAPI
· Microsoft.NSP.Caching.Utilities
· ErrorLog
3. 以下のレジストリ エントリを HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\SKTICaching に作成します。
· INSTALL_PATH_BACKEND
· DBConnectionString
· GC_Frequency
構成
キャッシュ システムがインストールされた後に、以下の構成を行う必要があります。
マシン: フロントエンド サーバー
ログイン ユーザー: ドメイン管理者
1. キャッシュ システムをインストールする Web サービスの web.config ファイルをメモ帳で開き、以下をファイルにコピーします。
タグ <configuration> の後:

<configSections>
<section name="microsoft.web.services" type="Microsoft.Web.Services.Configuration.WebServicesConfiguration, Microsoft.Web.Services, Version=1.0.0.0, Culture=neutral, PublicKeyToken=31bf3856ad364e35" />
<section name="microsoft.nsp.caching" type="Microsoft.NSP.Caching.CacheConfiguration, Microsoft.NSP.Caching, Version=2.0.0.1, Culture=neutral, PublicKeyToken=8df23fe390131e69" />

</configSections>

<microsoft.web.services>


<filters>



<output>
<add type="Microsoft.NSP.Caching.OutputFilter, Microsoft.NSP.Caching, Version=2.0.0.1, Culture=neutral, PublicKeyToken=8df23fe390131e69" />



</output>


</filters>

</microsoft.web.services>

<microsoft.nsp.caching>


<WebMethod>
<Method Name="<WebMethodName>" WebService=”<WebserviceURI>” IsCachable="<true/false>" TTL="<TTL value>" IsInProcCacheEnabled="<true/false>" IsServiceUnavailabilityDependencyEnabled="<true/false>" IsBindingEnabled="<true/false>" InvokeIpWSEPipeline="<true/false>" InvokeOpWSEPipeline="<true/false>" />
</WebMethod>


<Diagnostics>



<trace enabled="false" />


</Diagnostics>



</microsoft.nsp.caching>
Web サービスが SOAP 拡張機能をサポートするよう構成されていない場合は、タグ <system.web> の後の web.config ファイルに以下をコピーします。


<webServices>



<soapExtensionTypes>
<add type="Microsoft.Web.Services.WebServicesExtension, Microsoft.Web.Services, Version=1.0.0.0, Culture=neutral, PublicKeyToken=31bf3856ad364e35" priority="1" group="0" />



</soapExtensionTypes>


</webServices>

<system.web> の後に、以下を追加します。


<httpModules>
<add name="CacheModule" type="Microsoft.NSP.Caching.CacheModule, Microsoft.NSP.Caching, Version=2.0.0.1, Culture=neutral, PublicKeyToken=8df23fe390131e69" />
</httpModules>
キャッシュの各種機能を構成するのに使用する Web メソッド タグの属性を以下に示します。
	属性
	説明

	Name="<WebMethodName>"
	Web メソッドの名前です。

	WebService=”<WebServiceName>”
	現在のメソッドが属する Web サービスの URI です。

	IsCachable="<true/false>
	メソッドをキャッシュするよう構成する場合は True です。 その他の場合は false です。

	TTL="<TTL value>"
	Web メソッドの応答をデータベースまたは in-proc キャッシュにキャッシュする場合の整数値です。 時間は秒単位です。

	IsInProcCacheEnabled="<true/false>"
	応答をプロセス メモリにキャッシュする場合は True、それ以外の場合は false です。

	IsServiceUnavailabilityDependencyEnabled="<true/false>"
	Service Unavailability Dependency が有効な場合は True です。

	IsBindingEnabled="<true/false>"
	バインディング ウィザードをサポートするようメソッドを構成する場合は True です。

	InvokeIpWSEPipeline="<true/false>"
	WSE Input パイプラインを明示的に起動する場合は True、それ以外の場合は false です。

	InvokeOpWSEPipeline="<true/false>"
	WSE Output パイプラインを明示的に起動する場合は True、それ以外の場合は false です。


バックエンド サーバーで、次の操作を行います。
1. 以下に移動して、DACL Maintenance サービスを起動します。
[Start] -> [Programs] -> [Administrative Tools] -> [Services] の順にクリックし、[SKTICaching Maintenance Service] を起動します。
2. セットアップ後にフロントエンド サーバーで iisreset を実行します。
使用に関するガイドライン
コマンド ライン ユーティリティ
This utility provides the interface to invalidate cache at different granularities.このユーティリティは、各種粒度でキャッシュを無効にするインタフェースを提供します。 This can be accessed from <deploydir>\bin\InvalidateCache.exe. Here deploydir is the path of the directory and where DACL Caching Front-end has been installed.このユーティリティは <deploydir>\bin\InvalidateCache.exe からアクセスできます。deploydir はディレクトリのパスで、DACL キャッシュ フロントエンド サーバーがインストールされています。 
<deploydir>\bin\InvalidateCache.exe help はこのユーティリティの使用法の詳細を提供します。保守サービス
この Windows サービスは、無効および期限の切れたキャッシュを Out of Proc キャッシュ ストアから定期的に消去します。 この頻度はレジストリ キー HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\SKTI Caching\GC_Frequency で構成できます。
頻度は分単位の整数値で入力できます。 インストール後、ユーザーは Services Microsoft管理コンソールからサービスを起動する必要があります。 管理特権のあるユーザーは、レジストリ値を変更することで頻度の値を変更できます。 
注: 上記の変更内容を有効にするには、サービスを再起動する必要があります。
トラブルシューティング


データの抽象化およびキャッシュ レイヤの WebService バインディング フレームワーク
	問題
	原因
	ソリューション

	アダプタを登録または登録解除しているときに、セットアップでエラーが発生します。
	セットアップは、他のポートで使用中の場合は、WebServiceSendAdapter および MSMQC アダプタを登録または登録解除できません。
	インストール前にアダプタ名が既に存在する場合は、BizTalk 管理コンソールからそれらを削除してから、セットアップをインストールします。
セットアップのアンインストール処理中にアダプタが削除されていない場合は、セットアップを使用しているポートからアダプタの参照先を削除するか、アダプタを使用しているポートを削除します。 次に、BizTalk 管理コンソールからアダプタを削除します。

	イベント ビューアに以下のようなメッセージを表示されます。The Messaging engine failed to resolve the receive location "DIRECT=OS:.\private$\Employee" to the receive adapter "MSMQC". If this adapter was created in the Admin MMC after the service was started, please cycle the service
	データの抽象化およびキャッシュレイヤ 2.0 セットアップの完了後に、BizTalk Service BizTalk Service BizTalk Group: BizTalkServerApplication が再起動しませんでした。
	サービス BizTalk Service BizTalk Group: BizTalkServerApplicationを再起動します。

	メッセージが署名および暗号化されている場合、メッセージ キューに届きません。
	ネットワークの速度が遅くなっているか、メッセージが回線に流れるための有効期限より時間がかかっている可能性があります。
その他の原因としては、フロントエンド サーバーとパートナー サーバーとの時差が、5 分間など、許可時間より長い場合が考えられます。 既定では WSE では、SOAP ヘッダーに “Timestamp” プロパティが設けられています。 フロントエンド サーバーとバックエンド サーバー間の時差が既定値以上または以下になると、メッセージの有効期限が切れます。
	パートナー サーバーまたはフロントエンド サーバーの時間をリセットし、パートナー サーバーとフロントエンド サーバー間の差が制限時間内になるように設定します。

	イベント ビューアに以下のようなメッセージを表示されます。The receive location “DIRECT=OS:.\private$\Employee” is shutting down. Details: “Access to Message Queuing system is denied.”
	プロセスに、メッセージ キューにアクセスするのに十分なアクセス許可がありません。
	サービス BizTalk Service BizTalk Group: BizTalkServerApplication を実行するよう構成されたユーザーに、バインディングのためにバインディング ウィザードで作成されたメッセージ キューへの特権を与える必要があります。
1. [Control Panel] -> [Administrative Tools] -> [Services] の順にクリックし、サービス BizTalk Service BizTalk Group: BizTalkServerApplication を実行するよう構成されているユーザーを特定します。
2. [Administrative Tools under Control Panel] から [Computer Management] を開きます。
3. [Computer Management (Local)] で、[Services and Applications] を展開します。
4. [Message Queuing] を展開します。
5. [Private Queues] を展開します。
6. それぞれのメッセージ キューを特定し、右クリックします。
7. コンテキスト メニューで [Properties] をクリックします。
8. [Security] タブをクリックします。
9. [Name] ボックスでそのユーザーを見つけます。
注: ユーザーが存在しない場合は、次の操作を行います。
a. [Add] をクリックします。
b. 手順 1 で見つけたユーザーを追加します。
c. [OK] をクリックします。
10. [Name] ボックスでそのユーザーをクリックします。
11. [Permissions] ボックスで、以下のアイテムについてそのユーザーの [Allow] チェック ボックスがオンになっていることを確認します。
a. Receive Message
b. Peek Message
c. Send Message
12. [OK] をクリックします。

	イベント ビューアに Error Occurred in Function AddSecurity: -The handle is invalid というメッセージが表示されます
	MachineKeys フォルダ下のファイルに十分なアクセス許可がありません。
	『Data Abstraction and Caching Layer v2.0 Binding Wizard - Tutorial』の「Required Permissions for theWSE to Sign or Decrypt with an X.509 Certificate」セクションを参照してください。

	BizTalk Explorer でポートを作成または構成しようとすると、イベント ビューアに Invalid Pointer というエラーが表示されます。
	BizTalk Explorer の DB ツリーのノードが最新のデータベース値または ids で更新されていません。
	BizTalk Explorer の DB ツリーを最新の情報に更新します。

	BizTalk プロジェクトのコンパイル中に、イベント ビューアに Illegal Name というエラーが表示されます。
	現在のオーケストレーションで使用または作成されているポート名が、既存のポート名と競合しています。
	コンパイルしている現在のオーケストレーションの [Port] プロパティでポート名を変更します。

	BizTalk Explorer で作業しているときに、イベント ビューアで以下のエラーが表示されます。The following are the referencing of the transport type ‘…’ which no longer exists. <Send Port ‘…’>.
	現在のオーケストレーションで使用または作成されているポート名が、既存のポート名と競合しています。
	BizTalk Explorer の DB ツリーを最新の情報に更新します。


	バインディング ウィザード実行後、スキーマ ファイル (.xsd) がフォルダ <SKTIInstallationFolder>\Schemas に作成されません。
	.NET Framework 1.1 の WSDL 形式が .NET Framework 1.1 SP1 の形式と異なっています。
	[Add or Remove Programs] コントロール パネル アプレットを使用して Windows Server 2003 修正プログラム – KB を削除し、.NET Framework 1.1 SP1 をアンインストールします。

	
	
	


DACL キャッシュ
	問題
	原因
	ソリューション

	キャッシュ システムをインストール後、Web サービスにアクセスすると、以下のエラー メッセージが表示されることがあります。
System.Security.SecurityException: Requested registry access is not allowed.

	既定では、ASP.NET ワーカー プロセスのユーザー トークンは ASPNET です。 アカウントにイベント ソースを作成する正しいユーザー権利がないために問題が発生しています。 

	レジストリ エディタで Application Event Log 下にイベント ソースを作成します。 これを行うには、以下の手順に従います。
· [Start] をクリックして、[Run] をクリックします。 
· テキスト ボックスで、regedit と入力します。 
· 以下のレジストリ サブキーの場所を見つけます。
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\Eventlog\Application
· アプリケーション サブキーを右クリックし、[New] をポイントして、[Key] をクリックします。 
· キー名に SKTI を入力します。 
· レジストリ エディタを閉じます。
· アプリケーションを再度実行します。
注: .NET サーバーの場合、以下の変更も必要になります。
· [Start] をクリックして、[Run] をクリックします。 
· テキスト ボックスで、inetmgr と入力します。
· IIS MMC コンソールで、以下のパスに移動します。
[Local Computer] -> [Application Pools] -> [DefaultAppPool] 
· [DefaultAppPool] を右クリックし、[Properties] をクリックします。
· [Identity Tab View] に移動します。
· アプリケーション プールのセキュリティ アカウントをネットワーク サービスからローカル システム アカウントへ変更します。
ASP.NET アプリケーションが、既定の ID がシステム リソースにアクセスする十分な特権がないネットワーク サービスであるアプリケーション プールに結び付けられているためにこの変更が必要です。

	キャッシュ後、バックエンド サーバー システムがインストールされても、保守サービスがインストールされません。
	セットアップ中に .NET Framework フォルダに正しくないパスが指定されているために問題が発生しています。
	· バックエンド サーバーのセットアップを再実行します。
· [Repair] オプションをクリックし、.NET Framework インストール フォルダの正しい位置を指定します。

	強制無効化でも、In-Proc キャッシュが無効になりません。

	バックエンド サーバー セットアップ中に .NET Framework フォルダに正しくないパスが指定されているために問題が発生しています。

	· バックエンド サーバーのセットアップを再実行します。
· [Repair] オプションをクリックし、.NET Framework インストール フォルダの正しい位置を指定します。
SQL Server エージェントがローカル システム アカウント下で動作していることを確認します。
注: .NET サーバーの場合、上記で解決しない場合は、以下の変更を行う必要があります。
· [Start] をクリックして、[Run] をクリックします。 

· [Open] ボックスで、inetmgr と入力します。
· IIS MMC コンソールで、以下のパスに移動します。
· [Local Computer] -> [Application Pools] -> [DefaultAppPool] 
· [DefaultAppPool] を右クリックし、[Properties] をクリックします。
· [Identity Tab View] に移動します。
· アプリケーション プールのセキュリティ アカウントをネットワーク サービスからローカル システム アカウントへ変更します。
ASP.NET アプリケーションが、既定のID がシステム リソースにアクセスする十分な特権がないネットワーク サービスであるアプリケーション プールに結び付けられているためにこの変更が必要です。

	SQL 接続パラメータを入力した後にフロント エンド サーバーのセットアップが失敗します。

	バックエンド サーバーのSQL DB が破損している場合は、フロントエンド サーバーが正しくインストールされません。
	[Repair] オプションをクリックして、バックエンド サーバーのセットアップを再実行します。

	キャッシュ モジュールで以下のエラーが発生します。“Caching System was unable to Cache. Following Error message was found: Object reference not set to an instance of an object.”

	このバージョンのキャッシュは、バインディング ウィザード互換に対応していません。 したがって、web.config ファイルの “IsBindingEnabled” 属性が Trueに設定されていると、ヘッダーの正しくない SOAP メッセージはキャッシュされません。
	web.config ファイルの属性 IsBindingEnabled の値を False に設定します。



セキュリティの考慮事項
ここでは、データの抽象化とキャッシュレイヤ モジュール関連のセキュリティの考慮事項について説明します。
1. すべてのマシンを最新の修正プログラムで更新しておいてください。 

2. すべての Web サービスの HTTP Get および Post アクセスを無効にしてください。 SOAP アクセスのみ有効にします。 これは Web サービスの web.config で設定できます。 
3. 金融および証券業界では一般的な、コンタクト センターが回線上で情報を暗号化する必要がある場合は、すべての CCF Web サービスおよびデータベース接続に SSL を使用してください。 

CCF デモ パッケージ
この展開セクションは、デモ アプリケーションおよびその必要データを展開する場合に便利です。 これらのデモ アプリケーションを使用して、CCF モジュールの動作を理解したり、CCF フレームワーク機能を最大限に活用できます。 デモ アプリケーションの展開は任意です。
CCF デモ アプリケーション
このパッケージは、Web アプリケーション、Windows 制御による外部アプリケーション (スタンドアロン実行可能アプリケーション) など各種デモ ホスト アプリケーションとサンプル データのセットです。 CCF フレームワークの基本ホスト アプリケーション クラスから派生したこれらのアプリケーションは、他のホストアプリケーションでの表示操作、シングル サインオン、およびアプリケーション実行分離など各種機能を実証します。
これらの機能は、CCF フレームワーク機能を活用するホスト アプリケーションの開発者に非常に役立ちます。
これらのデモ アプリケーションを展開および使用するには、パッケージ内にある『CCF Demo Deployment Guide.doc』という展開ドキュメントを参照してください。
CSR デモ アプリケーション
このパッケージは、CCF をホスト アプリケーションとして構成できる 8 個のデモ アプリケーションで構成されています。 デモ アプリケーションは、カスタマ ケア イントラネット Web サイトをシミュレーションします。
これらのデモ アプリケーションを展開および使用するには、パッケージ内にある『CSR Demo Deployment Guide.doc』という展開ドキュメントを参照してください。
DACL デモ アプリケーション
Contact Center Framework (CCF) が BizTalk Server 2004 を使用してさまざまな基幹業務 (LOB) アプリケーションを統合する様子を示すためのものです。CCF は、顧客サービス担当者 (CSR) がこれらの LOB アプリケーションで非常に簡単に作業できる単一のインタフェースでさまざまな LOB アプリケーションをホストできます。 

このパッケージでは、LOB をシームレスに統合する CCF および BizTalk Server 2004 の機能を実証するため 3 個のサンプル Web ホスト アプリケーションが利用できるようになっています。
これらのアプリケーションを展開するには、パッケージ内の 『DACL Demo Deployment Guide.doc』を参照してください。
IBF ブローカー デモ パッケージ
このパッケージは、IBF ブローカーの使用方法を実証するのに必要なサンプル コンポーネントで構成されています。 これらのコンポーネントとして、サンプルの LOB アプリケーション、サンプルの LOB アプリケーション用サンプルの IBF 互換 Web サービス、および IBF ブローカーで Office 2003 とアクセスするのに必要な関連コンポーネントがあります。
これらのデモ アプリケーションを展開するには、パッケージ内の『IBF Demo Deployment Guide.doc』を参照してください。
付録 – A
エージェント デスクトップに関する ContactCenter DB のオプション テーブルの構成
以下に説明する CCF 一般設定を管理するには、管理コンソールを使用します。
	設定
	説明

	CtiType
	使用中の CTI 接続タイプを説明しています。  Demo、TAPI、または TSAPI になります。 顧客先で使用されている接続タイプに対応するために、テレフォニー クラスを変更することもできます。
0 = なし
1 = デモ
2 = TAPI
3 = TSAPI
4 = VoIP
5 = Avaya VTel プロトコル
注: パイロット展開では、CtiType に 0、1、または 2 を選択します。これらはパイロット展開シナリオで実証できる唯一の CTI タイプです。 TAPI エミュレータを使用する場合は、2 に設定します。残りの CtiTypes については、適切なハードウェアを使用し、CCF2.0 コードの CTI レイヤを変更する必要があります。

	PhoneAt_machineName
このエントリは、マシン名が電話に関連付けられたコンピュータを識別する各エージェント デスクトップに作成されています。
	エージェントが使用している電話番号または電話名です。  TSAPI およびデモでは、常に電話番号になります。  TAPI では、ベンダーに固有で、電話番号または電話名になります。
エージェント名 (例: Name=PhoneAt_マシン名, Value=Jane (3331) を識別するためにオプション テーブルに記載されたエントリ
これはローカル デスクトップの AgentDesktop.exe.config ファイルの AgentNumber キーを使用して上書きできます。


	warnAgentCallIsTooLong
	通話が長すぎます、という警告がデスクトップに表示されるまでの通話の経過時間を示す秒数です。これは、エージェントが要求時間以上顧客とつながっていることをユーザーに示すものです。 ユーザー インタフェースにはその結果は反映されません。単なるエージェントへのメッセージです。

	secondsBetweenTickerPolls
	エージェント デスクトップ ユーザー インタフェースのステータス バーに表示されるコンタクト センター統計情報を戻す Web サービスの読み取り間の秒数です。
-1 に設定されている場合は、ポーリングが無効になります。

	AuditGlobalPriority
	AuditGlobalPriority は、記録するイベントと無視するイベントを制御します。 このオプションは、0 および 4 を含む 0 から 4 の値をとります。既定の監査優先度は 2 に設定されます。これは、優先度が 2 以下のすべての監査ログ イベントが記録されることを意味します。 監査ログの記録を停止するには、値を 0 に設定します。

	csAppSummaryXSL
	csAppSummaryXSL は、顧客情報 XML に適用され、エージェントデスクトップのカレント セッション パネルに表示されるスタイル シートへの URI を示します。

	csBlankPageURL
	csBlankPageURL は、エージェント デスクトップでアクティブな顧客がいない場合に、カレント セッション パネルに表示されるページの URL を示します。

	HostedAppCallTimeout
	HostedAppCallTimeout は、エージェント デスクトップが分離アプリケーションからの応答を待つ秒数を示します。 分離アプリケーションがこの時間内に応答しない場合は、エージェント デスクトップはエラー メッセージを表示します。
DB に設定されている既定値は 30 秒です。

	ReportDataThresholdInDays
	エージェントのログイン セッション(ログイン操作の後にログアウト操作を行う)の監査データが、レポート生成のため考慮されています。 エージェントは同時に数日間エージェント デスクトップにログインしている場合があり、その場合はログイン操作に対応するログアウト操作はありません。 その場合、ReportDataThresholdInDays はエージェントの監査データを無視する日数のしきい値を示します。 


付録 – B
AzMan の構成
Windows 2003 の承認マネージャ (Azman) を使用して、ホスト アプリケーションに対してエージェントを承認します。 たとえば、コンタクト センターに 6 個のホスト アプリケーション (HA1 から HA6) がある場合は、Azman を使用して Agent1 が 3 個のホスト アプリケーション HA1、HA4、および HA6 のみ使用を承認するよう構成できます。 Azman は、XML ファイルの形式または Active Directory でコンタクト センターのすべてのエージェントについて上記の構成を格納します。 したがって、XML ファイルまたは Active Directory をストアの種類に使用して AzMan を構成できます。 Azman を構成するには、以下のセクション「CCF IIS サーバーでの AzMan の構成 (ストアの種類: XML)」または「CCF IIS サーバーでの承認マネージャ (AzMan) の構成 (ストアの種類: Active Directory)」の指示に従います。 
以下の操作はすべて管理コンソールで行うことができ、管理コンソールが使用できず、AzMan コンソールを使用してAzMan ストアでホスト アプリケーションを手動で管理しなければならない場合のみこれらのセクションに従います。
CCF IIS サーバーでの AzMan の構成 (ストアの種類: XML)
以下の手順は、XML ファイルを使用してエージェントにアクセスできるホスト アプリケーションの構成方法について説明しています。 

マシン: <IISSvr>
ログイン ユーザー: ローカル管理者
1. [Start] -> [Run] の順にクリックします。
2. regsvr32 <OSDRIVE>\WINDOWS\system32\azroles.dll を入力し、[OK] をクリックします。
3. このコマンドは azroles.dll を登録します。
4. [Start] -> [Run] の順にクリックします。
5. mmc と入力し、Enter キーを押します。  コンソール ルート ファイルのみ表示されていることがわかります。
6. [File] -> [Add/Remove Snap-in] の順にクリックします。
7. [Add] をクリックします。
8. 新しいウィンドウで [Authorization Manager] をクリックし、[Add] をクリックします。
9. 新しいウィンドウを閉じます。
10. [OK] をクリックします。 

11. [Authorization Manager] を右クリックし、[Open Authorization Store] をクリックします。
12. ストアの種類に [XML file] をクリックします。
13. <wwwrootDir>/ContactCenterAIF/AzManCCF.XML を参照します。  これで AZManCCF.xml ファイルが追加されました。  AZManCCF.xml ファイルが表示されていることがわかります。このファイルを展開すると groups ファイルおよび CCF ファイルが表示されます。
14. CCF アプリケーションを展開します。  (+) アイコンをクリックして CCF ツリーを展開し、CCF ファイルを展開します。
15. [Groups] をクリックします。  Groups フォルダをクリックすると、Agent、Admin、および Guest というフォルダが一覧表示されます。
16. [Agent] を右クリックし、[Properties] をクリックします。  

17. [Members] タブをクリックします。
18. [Add Windows Users and Groups] をクリックします。
19. Enter the object names to select フィールドで Domain Users を入力し、[OK] をクリックします。 これには、インストール手順のドメイン セクションで作成した CCFUSERS グループが含まれている必要があります。
20. [OK] をクリックします。
21. たとえば、[Microsoft Web] というホスト アプリケーションの範囲をクリックします。 

22. [Role Assignments] をクリックします。
23. [AgentUsers] ロールがその下にあるかどうか検証します。 ない場合は、以下の手順に従って [AgentUsers] ロールを追加します。
a. [Role Assignments] を右クリックします。
b. [Assign Roles…] をクリックします。
c. [AgentUsers] チェック ボックスをオンにします。
d. [OK] をクリックします。
24. [AgentUsers] を右クリックします。
25. [Assign Application Groups] をクリックします。
26. [Agent] をクリックし、[OK] をクリックします。 これで CCFUsers グループのすべてのメンバが Microsoft Web というホスト アプリケーションにアクセスできます。
27. 他のエージェントについてホスト アプリケーションを構成するには、手順 15 から 26 を繰り返します。
承認マネージャへの新規ホスト アプリケーションの追加
パイロット展開には、あるサンプルのホスト アプリケーションがあります。 これらのホスト アプリケーションはすべて承認マネージャに追加されています。 しかし展開プロセス中、新しいホスト アプリケーションはエージェントに対して作成されます。 承認マネージャでこれらのホスト アプリケーションの認証を管理するには、これらのアプリケーションを承認マネージャで追加および登録する必要があります。 これらのホスト アプリケーションを承認マネージャに追加するには、以下の手順に従います。 後で、エージェントは「Configuring AzMan on CCF IIS Server (XML as the store type)」または「Configuring Authorization Manager (AzMan) on CCF IIS Server with Active Directory as the store type」セクションの手順に従って、新規ホスト アプリケーションにアクセスできます。 
マシン: <IISSvr>
ログイン ユーザー: ローカル管理者
1. 上記のセクション「Configuring on CCF IIS サーバーでの AzMan の構成」に従って [Authorization Manager MMC] を開きます。
2. [CCF] を右クリックします。
3. [New Scope] をクリックします。
4. [Name] ボックスにホスト アプリケーション名を入力します。 名前は [Application] テーブルにある名前と同じでなければなりません。
5. 新たに作成されたホスト アプリケーションの範囲をクリックします。
6. [Role Assignments] を右クリックします。
7. [Assign Roles] をクリックします。
8. [AgentUsers] をクリックし、[OK] をクリックします。
9. 他のホスト アプリケーションを構成するには、手順 2 から 8 を繰り返します。
Azman ファイルは構成済みアプリケーション全体が AzmanCCF.xml に一覧表示されるよう事前に構成されます。これは、たとえば DemoAgent1、DemoAgent2、および DemoAgent3 ログインなどの Windows ログインをエージェント グループに追加することで構成済みホスト アプリケーションへのアクセスを設定できるように行います。 
Windows ログインの Sid (セキュリティ記述子) が各システムおよびログインで一意となる AzmanCCF.xml に追加されているため、これらのログインは事前に構成できません。 エージェントがこれらのアプリケーションにアクセスできるよう、Agent ロールを各ホスト アプリケーションに追加する必要があります。
CCF IIS サーバーでの承認マネージャ (AzMan) の構成 (ストアの種類: Active Directory)
以下の手順は、Active Directory を使用してエージェントにアクセスできるホスト アプリケーションの構成方法について説明しています。 ドメインが Windows 2003 機能レベルかどうか確認します。 Windows 2003 機能レベルにない場合は、ドメイン機能レベルに変更します。 詳細については、Windows 2003 ヘルプを参照してください。 
マシン: <IISSvr>
ログイン ユーザー: ローカル管理者
1. [Start] -> [Run] の順にクリックします。
2. mmc と入力し、Enter キーを押します。
3. [File] -> [Add/Remove Snap-in] の順にクリックします。
4. [Add] をクリックします。
5. 新しいウィンドウで [Authorization Manager] をクリックし、[Add] をクリックします。
6. 新しいウィンドウを閉じます。
7. [OK] をクリックします。
8. [Authorization Manager] を右クリックし、[Options] をクリックします。
9. [Development mode] をクリックし、[OK] をクリックします。 

10. [Authorization Manager] を右クリックし、[New Authorization Store] をクリックします。
11. [Active Directory] をクリックします。
12. [Store] 名で、[Program Data] を [AzManCCF] に変更し、[OK] をクリックします。
13. [AzManCCF] を右クリックし、[Properties] をクリックします。
14. [Security] タブをクリックします。
15. [Authorization Manager user role] ボックスで [Reader] をクリックします。
16. [Add] をクリックします。
17. 新しいウィンドウでドメイン ユーザー ASPUSER を入力し、[OK] をクリックします。
18. 親ウィンドウで [OK] をクリックします。
19. [AzManCCF] を右クリックし、[New Application] をクリックします。
20. [New Application] ダイアログ ボックスで、名前を CCF1.0 と入力し、[OK] をクリックします。
21. [CCF] 下で [Groups] を右クリックし、[New Application Group] をクリックします。
22. [New Application Group] ダイアログ ボックスで、名前を Agent と入力し、[OK] をクリックします。
23. [Agent] を右クリックし、[Properties] をクリックします。
24. [Agent Properties] ダイアログ ボックスで、[Members] タブをクリックします。
25. [Add Windows Users and Groups] をクリックします。
26. [Enter the object names to select] ボックスで Domain Users を入力し、[OK] をクリックします。
27. [OK] をクリックします。
28. CCF アプリケーション下の [Definitions] を開きます。
29. [Role Definitions] を右クリックし、[New Role Definition] をクリックします。
30. [Role Definition] ダイアログ ボックスで、名前を CCFUsers と入力し、[OK] をクリックします。
31. [CCF] を右クリックします。 
32. [New Scope] をクリックします。 

33. [Name] ボックスにホスト アプリケーション名を入力します。 名前は [Application] テーブルにある名前と同じでなければなりません。
34. 新たに作成されたホスト アプリケーションの範囲をクリックします。
35. [Role Assignments] を右クリックし、[Assign Roles] をクリックします。
36. [CCFUsers] をクリックし、[OK] をクリックします。
37. [CCFUsers] を右クリックし、[Assign Application Groups] をクリックします。 
38. [Agent] をクリックし、[OK] をクリックします。
39. 新しいホスト アプリケーションを構成するには、手順 31 から 40 を繰り返します。
40. Contact Center AIF Web Services インストール ディレクトリの (“<wwwrootDir>\ContactCenterAIFWebServices”) Web.CONFIG ファイルを開きます。
41.  AzManStore 値を "msldap://CN=AzManCCF,DC=CCF,DC=Demo" に更新します。‘CCF’ はこのパイロット展開では CCF の NetBIOS ドメイン名になります。 このドメイン名が ‘CCF’ でない場合は、適切なドメイン名を指定してこの文字列値を変更します。
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